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Safety Instructions
Safety Instructions • English

WARNING:	 This symbol, , when used on the product, is intended to 
alert the user of the presence of uninsulated dangerous voltage within the 
product’s enclosure that may present a risk of electric shock.

ATTENTION:	 This symbol, , when used on the product, is intended 
to alert the user of important operating and maintenance (servicing) 
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron website, 
www.extron.com.

Instructions de sécurité • Français

AVERTISSEMENT:	 Ce pictogramme, , lorsqu’il est utilisé sur le 
produit, signale à l’utilisateur la présence à l’intérieur du boîtier du produit 
d’une tension électrique dangereuse susceptible de provoquer un choc 
électrique.

ATTENTION:	 Ce pictogramme, , lorsqu’il est utilisé sur le produit, 
signale à l’utilisateur des instructions d’utilisation ou de maintenance 
importantes qui se trouvent dans la documentation fournie avec le 
matériel.

Pour en savoir plus sur les règles de sécurité, la conformité à la réglementation, 
la compatibilité EMI/EMF, l’accessibilité, et autres sujets connexes, lisez les 
informations de sécurité et de conformité Extron, réf. 68-290-01, sur le site 
Extron, www.extron.com.

Sicherheitsanweisungen • Deutsch

WARNUNG:	 Dieses Symbol  auf dem Produkt soll den Benutzer 
darauf aufmerksam machen, dass im Inneren des Gehäuses dieses 
Produktes gefährliche Spannungen herrschen, die nicht isoliert sind 
und die einen elektrischen Schlag verursachen können.

VORSICHT:  Dieses Symbol  auf dem Produkt soll dem Benutzer in der 
im Lieferumfang enthaltenen Dokumentation besonders wichtige Hinweise 
zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen über die Sicherheitsrichtlinien, Produkthandhabung,  
EMI/EMF-Kompatibilität, Zugänglichkeit und verwandte Themen finden Sie in 
den Extron-Richtlinien für Sicherheit und Handhabung  (Artikelnummer  
68-290-01) auf der Extron-Website, www.extron.com.

Instrucciones de seguridad • Español

ADVERTENCIA:	 Este símbolo, , cuando se utiliza en el producto, 
avisa al usuario de la presencia de voltaje peligroso sin aislar dentro del 
producto, lo que puede representar un riesgo de descarga eléctrica.

ATENCIÓN:	 Este símbolo, , cuando se utiliza en el producto, avisa 
al usuario de la presencia de importantes instrucciones de uso y 
mantenimiento recogidas en la documentación proporcionada con el 
equipo.

Para obtener información sobre directrices de seguridad, cumplimiento 
de normativas,  compatibilidad electromagnética, accesibilidad y temas 
relacionados, consulte la  Guía de cumplimiento de normativas y seguridad de 
Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.com.

Инструкция по технике безопасности • Русский

ПРЕДУПРЕЖДЕНИЕ:	 Данный символ, , если указан 
на продукте, предупреждает пользователя о наличии 
неизолированного опасного напряжения внутри корпуса 
продукта, которое может привести к поражению 
электрическим током.

ВНИМАНИЕ: 	 Данный символ, , если указан на продукте, 
предупреждает пользователя о наличии важных инструкций 
по эксплуатации и обслуживанию в руководстве, 
прилагаемом к данному оборудованию.

Для получения информации о правилах техники безопасности, 
соблюдении нормативных требований, электромагнитной 
совместимости (ЭМП/ЭДС), возможности доступа и других 
вопросах см. руководство по безопасности и соблюдению 
нормативных требований Extron на сайте Extron: www.extron.com, 
номер по каталогу - 68-290-01.

Chinese Simplified（简体中文）

警告： 产品上的这个标志意在警告用户该产品机壳内有暴露的危险 电压，
有触电危险。

注意： 产品上的这个标志意在提示用户设备随附的用户手册中有 
重要的操作和维护(维修）说明。

关于我们产品的安全指南、遵循的规范、EMI/EMF 的兼容性、无障碍 
使用的特性等相关内容，敬请访问 Extron 网站 www.extron.com，参见 
Extron 安全规范指南，产品编号 68-290-01。

Chinese Traditional（  )

警告: 若產品上使用此符號，是為了提醒使用者，產品機殼內存在著 
可能會導致觸電之風險的未絕緣危險電壓。

注意	  若產品上使用此符號，是為了提醒使用者，設備隨附的用戶手冊中有重
要的操作和維護（維修）説明。

有關安全性指導方針、法規遵守、EMI/EMF 相容性、存取範圍和相關主題的詳細資
訊，請瀏覽 Extron 網站：www.extron.com，然後參閱《Extron 安全性與法規
遵守手冊》，準則編號 68-290-01。

Japanese

警告:	 この記号  が製品上に表示されている場合は、筐体内に絶縁されて 
いない高電圧が流れ、感電の危険があることを示しています。

注意:	 この記号  が製品上に表示されている場合は、本機の取扱説明書
に 記載されている重要な操作と保守(整備)の指示についてユーザーの 注
意を喚起するものです。

安全上のご注意、法規厳守、EMI/EMF適合性、その他の関連項目に  
ついては、エクストロンのウェブサイト www.extron.com より 『Extron Safety 
and Regulatory Compliance Guide』 (P/N 68-290-01) をご覧ください。

Korean

경고: 	 이 기호  가 제품에 사용될 경우, 제품의 인클로저 내에 있는 
접지되지 않은 위험한 전류로 인해 사용자가 감전될 위험이 있음을 
경고합니다.

주의:	 이 기호  가 제품에 사용될 경우, 장비와 함께 제공된 책자에 나와 
있는 주요 운영 및 유지보수(정비) 지침을 경고합니다.

안전 가이드라인, 규제 준수, EMI/EMF 호환성, 접근성, 그리고 관련 항목에 
대한 자세한 내용은 Extron 웹 사이트(www.extron.com)의 Extron 안전 및 
규제 준수 안내서, 68-290-01 조항을 참조하십시오. 
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www.extron.com
www.extron.com
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FCC Class A Notice
This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to part 15 of the FCC rules. The Class A limits provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause interference. This interference must be corrected at 
the expense of the user.

NOTE:	 For more information on safety guidelines, regulatory compliances, EMI/EMF compatibility, 
accessibility, and related topics, see the “Extron Safety and Regulatory Compliance 
Guide” on the Extron website.

Copyright
© 2014  Extron Electronics. All rights reserved.

Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.

The following registered trademarks®, registered service marks(SM), and trademarks(TM) are the property of 
RGB Systems, Inc. or Extron Electronics:

Registered Trademarks (®)

AVTrac, Cable Cubby, CrossPoint, eBUS, EDID Manager, EDID Minder, Extron, Flat Field, GlobalViewer, Hideaway, Inline, IP Intercom, 
IP Link, Key Minder, LockIt, MediaLink, PlenumVault, PoleVault, PowerCage, PURE3, Quantum, SoundField, SpeedMount, SpeedSwitch, 
System INTEGRATOR, TeamWork, TouchLink, V‑Lock, VersaTools, VN‑Matrix,  VoiceLift, WallVault, WindoWall, XTP, and XTP Systems

Registered Service Mark(SM) :  S3 Service Support Solutions

Trademarks (™)

AAP, AFL (Accu‑Rate Frame Lock), ADSP (Advanced Digital Sync Processing),  Auto‑Image, CDRS (Class D Ripple Suppression), CableCover, 
DDSP (Digital Display Sync Processing), DMI (Dynamic Motion Interpolation), Driver Configurator, DSP Configurator, DSVP (Digital Sync 
Validation Processing), EQIB, FastBite, FOXBOX, Global Configurator, IP Intercom HelpDesk, MAAP, MicroDigital, ProDSP, QS-FPC (QuickSwitch 
Front Panel Controller), Scope‑Trigger, SIS, Simple Instruction Set, Skew‑Free, SpeedNav, Triple‑Action Switching, XTRA, ZipCaddy, ZipClip
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Conventions Used in this Guide

Notifications
The following notifications are used in this guide:

ATTENTION:	

•	 Risk of property damage. 
•	 Risque de dommages matériels.

NOTE:	 A note draws attention to important information.

TIP:	 A tip provides a suggestion to make working with the application easier.

Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C

[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

E X! *X1&* X2)* X2#* X2! CE}

NOTE:	 For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” is the capital 
letter “o.”

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron

Variables are written in slanted form as shown here:
ping xxx.xxx.xxx.xxx —t

SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.
Click the OK button.

Specifications Availability
Product specifications are available on the Extron website, www.extron.com.
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Introduction

This section gives an overview of the guide and features of the Quantum Elite Control 
Software and Quantum Connect Control Software. Topics include:

•	 About this Guide

•	 Overview of the Quantum Control Software

•	 Features

About this Guide
This guide provides detailed information about the Quantum Elite Control Software and 
Quantum Connect Control Software, including software installation and configuration. 
This guide also describes how these applications control the Quantum Elite and Quantum 
Connect videowall processors.

The features and functionality described in this guide are based on using version 1.8 of 
the Quantum control software applications with Quantum Elite and Quantum Connect 
firmware version 9.0 and later. For the latest details on firmware and software, visit 
www.extron.com.

In this guide, the term “Quantum Control Software” refers to both the Quantum Elite Control 
Software and Quantum Connect Control Software. The terms “Quantum” and “Quantum 
processor” refer to both the Quantum Elite and Quantum Connect videowall processors. 
Notes distinguish where features differ between the Quantum Elite and Connect Control 
Software programs and between the Quantum Elite and Connect processors. 

Overview of the Quantum Control Software
Quantum Elite Control Software and Quantum Connect Control Software are Microsoft® 
Windows®-based applications that are used to control the Quantum Elite and Quantum 
Connect videowall processors. These products form part of the Extron Quantum series.

With the Quantum Control Software, the Quantum Elite and Connect can display multiple 
image sources on a single target display or multiple target displays. External analog and 
digital video sources (such as PAL or NTSC) and external analog and digital graphics 
sources are supported. The Quantum processors also support the use of internal image files 
(such as BMP, JPG, GIF, or PNG formats) or RGB computer graphics captured using the 
QGE 100 Quantum Graphics Encoder.

The feature set supported by the Quantum Elite Control Software differs slightly from the 
Quantum Connect Control Software. These differences are distinguished in this user guide. 

NOTE:	 Quantum Elite Control Software is not compatible with the Quantum Connect 
processor and vice versa.

Quantum Control Software • Introduction 1
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Features
Features of the Quantum Control Software include:

•	 The user interface is organized into a series of tasks so that you can easily navigate 
through them and set up the videowall.

•	 A virtual canvas provides an on-screen layout for the videowall where windows can be 
added, sized, and positioned.

•	 Custom videowall configurations can be saved as window presets for future recall.

•	 The software lets you create a custom user interface so that the system operator can 
easily recall the presets (scenes). 

Scene control

Each source is displayed in a resizable window within the Quantum Control Software, 
allowing multiple sources to be placed in any position on the display.

The Quantum Control Software stores different source layouts for the display as scenes, 
which are presets that include the size, position, and contents of one or more windows. 
Scenes can be recalled in any order using a customizable user interface or in a predefined 
order at specific time intervals using the Auto Play function (see the Creating a Project 
section beginning on page 41 and the Viewing a Project section beginning on page 61).

Scenes can also be recalled remotely via RS-232 (see Serial Commands beginning on 
page 70).

Quantum Control Software • Introduction 2



Installation and 
Operation

This section describes the software installation and communication setup for the Quantum 
Control Software and describes the software operation. Topics include:

•	 Requirements

•	 Software Installation

•	 Configuring the Hardware

•	 Using the Quantum Control Software

Requirements

System Requirements
To ensure that the Quantum Control Software functions correctly and reliably, you must 
install it on a computer that meets or exceeds the following criteria:

Minimum Recommended

Operating System Windows XP® Windows 7 or Windows 8 
(32-bit or 64-bit)

Processor Speed 1 GHz 1 GHz or higher

Memory (RAM) 1 GB 1 GB or higher

Hard Disk Free Space 30 MB More than 30 MB

Graphics 1024x768, 65K colors 
(16-bit)

1920 x 1080, 16.7M colors 
(32-bit)

Network Card (Ethernet) 10Base-T 100BASE-T
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Network Requirements
The Quantum Elite and Quantum Connect use specific network ports for communication. 
Ensure that these ports are accessible. 

Quantum Elite 

The Quantum Elite uses the following port numbers:

Port Number Use

Control 1237 Quantum discovery (UDP)

7004 System configuration (TCP)

7005 Scene control (TCP)

7006 System events (TCP)

Media 1 and Media 2 5000 Multicast reception of QGE 100 data 
stream (UDP)

37533 Discovery via Extron QGE 100 Computer 
Screen Capture IP Encoder (UDP)

37532 Reception of QGE 100 data stream (TCP)

Quantum Connect 

The Quantum Connect uses the following port numbers:

Port Number User

Control 1238 Quantum discovery (UDP)

7007 System configuration (TCP)

7008 Scene control (TCP)

7006 System events (TCP)

Image Processing Hardware
The Quantum Control Software is used in conjunction with a Quantum Elite or Quantum 
Connect videowall processor. Quantum Elite hardware consists of a 4U or 6U card frame 
into which various input and output cards are installed. The Quantum Connect is available 
only as a 4U frame. See the Quantum User Guide for more information about the Quantum 
Elite and Quantum Connect, including connector pinouts and processing capability.

Except for defining an IP address, it is not necessary to perform any setup procedures on 
the Quantum processor itself. System configuration is done through the control software.

Software Installation
To install the Quantum Control Software from the Extron Videowall Processing disc:

1.	 Insert the Extron Videowall Processing disc into the CD or DVD drive of your computer.

2.	 From the Windows desktop, open My Computer and select the appropriate disk drive.

3.	 Open the Quantum Connect or the Quantum Elite folder, depending on your device. 

4.	 Open the appropriate software subfolder for your Quantum processor.

5.	 Run the Quantum Connect_Setupvn.nnn.exe file (for the Quantum Connect) or the 
Quantum Elite_Setupvn.nnn.exe file (for the Quantum Elite).

6.	 Follow the remaining system prompts to complete the installation.
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Configuring the Hardware

Connecting to a Quantum Elite or Quantum Connect
The computer with the installed Quantum Control Software communicates with the 
Quantum via Ethernet. This can either be a direct or indirect connection, as shown in 
figure 1. Connection to a single videowall processor can use either method, but multiple 
videowall processors must use the indirect method (for example, via a hub).
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Figure 1.	 Methods of Connecting the Quantum Elite Control Software Computer 
to a Quantum Elite Processor

•	 A direct connection uses a single cable that is connected between the network port 
of the computer and the Quantum Elite or Quantum Connect. You must use a crossover 
cable; a straight-through cable does not work. The network port on the computer must 
be capable of supporting a 10BASE-T connection as required by the Quantum.

•	 An indirect connection is made via a hub, switch, or local area network, using a  
straight-through cable. A crossover cable does not work. The hub or switch connected 
to the computer must be capable of supporting a 10BASE-T connection as required by 
the Quantum.

Extron recommends using only CAT 5 shielded twisted pair cables. A 16-foot crossover 
cable is supplied with the Quantum processor. 

See the Quantum User Guide for further details on cable requirements and connector 
pinouts.
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Setting the IP Address of the Computer
The network port on the computer must be configured to use the same communications 
protocol as the Quantum, which is TCP/IP. The computer must also be allocated an IP 
address on the same subnet as the Quantum (see IP Addressing on page 95). 

To change the IP address for your computer, follow the instructions provided in your 
Windows program help file.

NOTE:	 If the computer is already connected to (and configured for) an existing network, 
consult the network administrator before making any changes. In addition, you need 
to be logged on with administrative rights before you can change Windows network 
settings.

Testing the Ethernet Link
To test the operation of the Ethernet link between the computer and the Quantum, you can 
use the Ping utility as follows:

1.	 Enter a ping command from your desktop.

•	 Windows XP, 2000, and NT: 

a.	 On the desktop, click Start > Run. The Run dialog box opens.

b.	 In the Run dialog box, type the following command: 
ping nnn.nnn.nnn.nnn —t 
where nnn.nnn.nnn.nnn is the IP address of the Quantum that you want to 
test.

c.	 Click OK or press the <Enter> key.

•	 Windows 7:

a.	 On the desktop, click Start.

b.	 In the Search programs and files field at the bottom of the Start menu, 
enter ping nnn.nnn.nnn.nnn —t and press <Enter>.

•	 Windows 8:

a.	 Search for CMD.

b.	 Double-click the cmd.exe application icon.

c.	 On the command line, type the following command: 
ping nnn.nnn.nnn.nnn —t 
where nnn.nnn.nnn.nnn is the IP address of the Quantum that you want to 
test.

d.	 Click OK or press the <Enter> key. A command window opens. 

One of the following response messages is displayed, indicating the state of the 
communications link:

•	 Reply from nnn.nnn.nnn.nnn: bytes=nn times=nms TTL=nn

This is the desired response, which indicates that the device at the specified 
address is communicating directly. The response time value may vary according to 
network traffic.

Example: If you send a ping command to a Quantum with the address 
208.132.180.48, you should get a message similar to the following: 
Reply from 208.132.180.48: bytes=32 times=2ms TTL=32
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•	 Request timed out

There has been no response from the specified address. Either the videowall 
processor is not receiving data from the computer or is not sending data back. 
Check that the Quantum Elite or Quantum Connect is powered up and set to the 
same address to which you sent the ping command. Also, check that you are using 
the correct type of connecting cables for your setup (straight-through or crossover) 
and that they are not damaged or faulty.

•	 Reply from nnn.nnn.nnn.nnn: Destination host unreachable, 

The IP address of the computer is not in the same class as that of your Quantum 
(see IP Addressing on page 95). See your Windows program help file for 
instructions for changing your computer IP address.

2.	 To close the ping utility, press <Ctrl + C> on your keyboard or click the X button in the 
upper-right corner of the command window.

Using the Quantum Control Software

Starting and Exiting the Quantum Control Software
You can run the Quantum Control Software using any of the following methods:

•	 Double-click the Quantum Elite or Quantum Connect icon on the desktop.

•	 From the desktop, click Start > All Programs > Extron Electronics >  
Quantum Elite (or Quantum Connect).

•	 Double-click a project file (the file name has a CTP extension) in Windows Explorer.

If the Access Control feature has been enabled, a Login dialog box is displayed. Select an 
appropriate logon level and enter a password (see the Access Control section beginning 
on page 81).

The Quantum Control Software splash screen appears for a few seconds followed by the 
main application window (see Main Application Window on the next page). 

You can exit the Quantum Control Software using any of the following methods:

•	 From the File menu, select Exit.

•	 Click the  button at the top right corner of the application window.

•	 Double-click the icon in the top left corner of the application window, or  
single-click the same icon and select Close from the drop-down menu.

If you have not saved your project, a message is displayed asking whether you want to save 
any changes. Click Yes or No to close the prompt.
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Main Application Window
The Quantum Control Software application window contains the following elements:

Figure 2.	 Elements of the Main Application Window

A Title bar D Taskbar

B Menu bar E Workspace

C Toolbar F Status bar

A	 Title bar — Shows the name of the currently loaded project.

B	 Menu bar — Provides a selection of drop-down menus to access various functions in  
the Quantum Control Software. Most of the menu functions can also be performed 
by buttons on the toolbars. The available menus change according to which task is 
currently selected in the taskbar.

C	 Toolbars — The various toolbars within the Quantum Control Software allow quick 
access to the most commonly used functions within the currently selected task. Most 
of these functions can also be performed using the menu bar. To hide or show a toolbar 
for the current task, open the View menu and select the desired toolbar. A check mark 
beside the menu option denotes that the toolbar is open in the application. You can also 
click and drag open toolbars to rearrange them in the application window. 
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D	 Taskbar — Each major task within the Quantum Control Software is represented by 
an icon in the taskbar. To select a task, click the appropriate button. This displays the 
workspace, menus, and toolbars associated with the selected task.

The standard set of tasks includes:

•	 Choose Display Processors	 •	 Scene Design

•	 Choose Layout	 •	 Scene Control

•	 Communications Setup	 •	 Remote Access Setup

•	 Set Up Sources	 •	 EDID Minder

Fewer tasks may be displayed depending on security settings.

E	 Workspace — Each task in the taskbar has its own workspace. The workspace 
contains the controls and functionality needed to complete the task.

F	 Status bar — Shows information about the current status of the Quantum Control 
Software. From the View menu, select Status Bar to hide or show the status bar.

Starting a New Project
When you run the Quantum Control Software for the first time after installation, a new 
untitled project (presentation) is created with no system configuration settings (see figure 2 
on the previous page).

Thereafter, you can start a new untitled project by either of the following methods:

•	 Retain the existing system configuration (for example, to create a new project for the 
same system) by one of the following methods: 

•	 Click the button on the main toolbar. 

•	 From the File menu, select New.

•	 Press <Ctrl + N> on the keyboard.

•	 Create a completely new project with no system configuration (for example, to make a 
new project for a different system). To create a new project:

3.	 Exit the Quantum Control Software (see Starting and Exiting the Quantum 
Control Software on page 7 for instructions).

4.	 While holding down the <Shift> key on the keyboard, run the Quantum Control 
Software (see Starting and Exiting the Quantum Control Software). When the 
Quantum Control Software main screen opens, release the <Shift> key.

To give your untitled project a name, save it as the desired name (see Saving a Project on 
page 10). 

See the System Configuration section beginning on page 12 if you are creating a project 
for a new system or need to make changes to the existing configuration.

See the Creating a Project section beginning on page 41 for information about placing 
sources on the target display.
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Loading an Existing Project

1.	 Click the  button on the main toolbar

- or -

From the File menu, select Open

- or - 

Press <Ctrl + O> on the keyboard.

The Open dialog box appears.

2.	 Locate the file to be loaded and click Open.

Saving a Project
To save the current project:

1.	 Click the  button on the main toolbar. You can also select Save from the File menu 
or press <Ctrl + S> on the keyboard.

2.	 If the project has not been saved previously (untitled), the Save As dialog box opens, 
allowing you to specify a name.

To save a copy of the open project:

1.	 From the File menu, select Save As. The Save As dialog box opens.

2.	 In the File Name field, enter a name for the project copy. A CTP extension is 
automatically appended to the file name.

3.	 Click Save to save the file.

When creating a project, save your work regularly. You can also have the Quantum Control 
Software automatically create backup files at regular intervals (see “Using Auto-Backup”).

Using Auto-backup
The Quantum Control Software can automatically back up your project at specific intervals. 
In the event that any changes are lost before saving (such as due to a power outage), you 
may be able to limit the amount of work you lost by restoring the last auto-backup file.

Setting the backup timer

1.	 From the Backup menu, select Setup Backup Timer. The Backup Setup Dialog box 
opens.

Figure 3.	 Backup Setup Dialog Box

2.	 Ensure that the Disable Backup check box is cleared to enable auto-backup.

NOTE:	 If you do not want to use auto-backup, ensure that the Disable Backup 
check box is selected.
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3.	 In the Hours and Minutes fields, enter the values to set the desired interval between 
each backup.

4.	 In the Backup Folder field, enter the full path of the Windows folder where the backup 
files are to be saved (by default, these are saved in the Quantum Elite or the Quantum 
Connect folder) 

- or - 

In the Backup Folder field, click Browse to navigate to the folder where the files are to 
be saved.

5.	 Click OK.

Restoring an auto-backup file

1.	 From the Backup menu, select Restore. If you made changes to the current file, you 
are prompted to save the file first.

2.	 In the Save prompt, click Yes to save the current file. The Save As dialog box opens if it 
is an untitled file.

- or - 

Click No to exit the current file without saving.

The Open dialog box is displayed.

NOTE:	 Backup files are contained within folders according to the date they were 
created. The files are named with the project title and the time they were created.

3.	 Double-click the folder for the desired date to open it.

4.	 Select the backup file that you want to restore and click Open.
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System 
Configuration

This section describes the four procedures or tasks associated with configuring the  
Quantum Control Software to work correctly with a Quantum videowall processor. Topics 
include:

•	 Choosing a Display Processor

•	 Layout Configuration

•	 Communications Setup

•	 Setting Up Sources

•	 Defining EDID

The tasks described in this section can be completed in any order but the order in which 
they are listed above is recommended. Unless otherwise stated, all configuration settings 
described in this section are saved in the project (CTP) file.

Choosing a Display Processor
Before the Quantum Control Software can control a Quantum, it must detect and be 
connected to the processor via the Choose Display Processors task.

NOTE:	 Quantum Connect does not support the use of multiple processors.
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1.	 Click the Choose Display Processors button in the taskbar  
(see figure 2, D, on page 8).

The Choose Display Processors workspace opens. 

Figure 4.	 Choose Display Processors Workspace

2.	 Click the  button on the main application window toolbar (see figure 4)

- or -

From the Detect menu, select Detect.

The Quantum Control Software polls for any Quantum processors accessible via its 
Ethernet port. An information panel is displayed for each processor detected, as shown 
in figure 4.

3.	 Select the Connect check box to the right of the IP address of the desired processor. If 
you are using more than one Quantum, connect to each one in the same manner.

NOTE:	 If the check box does not stay selected, this indicates that the  
Quantum Control Software is unable to establish or maintain a connection (for 
instance, due to a faulty cable or the Quantum processor and PC not being on the 
same IP subnet).

You can disconnect from a Quantum processor by clearing its Connect check box.
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Assigning a Name to a Quantum Processor
If you are using the Quantum Control Software to control more than one processor, you 
can give a name to each Quantum that easily identifies its role within the system. This is 
especially useful when you are assigning processors to the target display screens.

For example, if you are using two processors driving the left and right sides of the target 
display array, you can name the two processors Left and Right, respectively.

To assign a name, enter a suitable name in the Name field for the processor.

Layout Configuration

Choosing a Display Layout
The target display can be a single screen or several screens interlocked to form a larger 
display area. Therefore, you need to define the layout within the Quantum Control Software.

The selected layout appears as the virtual display in the Scene Design task (see the 
Creating a Project section beginning on page 41). This allows you to place sources 
exactly where you want them to appear on the actual display array.

Use the Choose Layout task to choose and configure the display layout.

To choose and configure a layout:

1.	 Click the Choose Layout button on the taskbar.
 

The Choose Layout workspace opens.

Figure 5.	 Choose Layout Workspace
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2.	 In the Choose Layout workspace, click the display layout diagram that matches the 
arrangement of your target display screens. The currently selected layout is highlighted 
with a blue background and red outline.

TIP:	 If the default layouts do not match your display configuration, see Designing 
a New Layout on page 17 or Modifying an Existing Layout on page 18.

3.	 Right-click a dark gray screen rectangle (usually starting with the top left screen) in the 
chosen layout and select Change Screen Processor IP from the drop-down list. The 
following dialog box opens:

Figure 6.	 Set Options Dialog Box

4.	 From the Processor IP drop-down list, select the IP address of the processor you are 
using. The Processor IP drop-down list displays all processors currently connected to  
the Quantum Control Software via the Choose Display Processors task. If no processors 
are listed, connect to one (see Choosing a Display Processor on page 12).

5.	 The Available Outputs drop-down list displays currently unassigned output cards (by 
slot number). Select one to assign to this screen.

NOTE:	 There are two output channels on each output card. Selecting from the 
Available Outputs list assigns the primary output (channel 1) to the screen. The 
secondary output (channel 2) is assigned automatically using the Second Output 
setting (see figure 7 on the next page for examples).
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Figure 7.	 Example Display Layouts and Channel Configurations

6.	 In the Second Output panel, select how the secondary output should be assigned (see 
figure 6 on the previous page). Choose from:

•	 Horizontal — The secondary output is assigned to the screen immediately to the 
right of the primary output (when viewed from the front of the display).

•	 Vertical — The secondary output is assigned to the screen immediately below the 
primary output.

•	 Do not Assign — The secondary output is not assigned; only the primary output is 
used.

7.	 Click OK to confirm the assignments.

NOTE:	 Screens that have been assigned or mapped appear with green 
backgrounds in the layout diagram. Unassigned screens have gray backgrounds.

8.	 Repeat steps 3 through 7 for each remaining screen in the layout.
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Designing a New Layout
If the desired target display layout is not one of the options available by default, you can 
create rectangular layouts as follows:

1.	 From the Layouts menu on the main application window menu bar (see figure 2, B, 
on page 8), select New. The New Wall Layout dialog box opens.

Figure 8.	 New Wall Layout Dialog Box

2.	 In the Name field, enter a name or brief description for the layout.

3.	 In the Wall layout panel, set the overall horizontal and vertical size of the target display 
(measured in whole screens) by clicking the Left and Right Arrows in the Columns 
field and the Up and Down Arrows in the Rows field. Alternatively, you can enter the 
desired values in the Columns and Rows fields.

4.	 From the Output Mode drop-down list, select the desired resolution of each screen.

5.	 From the HDMI Format drop-down list, select whether to transmit HDMI data as part of 
the digital output. 

•	 Select Automatic (the default) to automatically detect if the connection is to a 
display that is compatible with HDMI. 

•	 Select DVI RGB 444 to specify that the signal does not contain the Info frame or 
other ancillary data.

•	 Select HDMI RGB 444 to force the Quantum to transmit the Info frame in the digital 
output signal. 

6.	 From the HDCP Notification drop-down list, select whether to enable or disable 
HDCP Notification. If HDCP notification is enabled, the display indicates when HDCP 
content restrictions are preventing a video signal from passing. 

•	 Select Enabled to display a green screen with the text HDCP Content in the 
window if the connected device is not HDCP-capable and an HDCP input has been 
selected. 

•	 Select Disabled to mute the window to black if the connected device is not 
HDCP-capable and an HDCP input has been selected.
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7.	 To enable mullion compensation, select the Mullion Adjustment radio button in the 
Mullion/Edge Blending Compensation panel. Mullion is the area of frame border that 
exists between two displays. This area must be taken into account so that when an 
image is spread across two or more displays, the image flow is not distorted. 

8.	 If you are using projectors that support soft edge blending, select the Edge Blend 
Compensation radio button and use the controls in the Mullion/Edge Blending 
Compensation panel to set the required amount of overlap.

NOTES:	

•	 The Quantum Elite compensates for the edge blend area but does not adjust 
the brightness in the area.

•	 The Quantum Connect does not support the use of edge blended displays.

9.	 Select the Link check box to link the horizontal and vertical adjustment values. When 
the check box is selected, the Vertical field is grayed out and equals the horizontal 
value.

- or -

If you clear the Link check box, you can enter separate values for the horizontal and 
vertical adjustment.

10.	Click OK to save the new layout.

Modifying an Existing Layout
1.	 Right-click a screen in the chosen layout and select Edit Wall Layout from the  

drop-down list. The Wall Layout Properties dialog box opens.

2.	 Edit the various settings as needed (see Designing a New Layout on the previous 
page).

3.	 Click OK to save the layout.

Importing a Layout
To import display layouts from another Quantum Control Software file (with a CTP file 
extension):

1.	 From the Layouts menu, select Import. The Import Wall Layout dialog box opens.

2.	 Locate the file that contains the desired layout and click Open.

NOTE:	 This imports all layouts from the selected file that are not already in the existing 
file. 

Deleting a Layout
To delete any of the display layouts that appear in the Choose Layout workspace:

1.	 Click on the layout to be deleted.

2.	 From the Layouts menu, select Delete.

NOTE:	 If you want to undo this operation, exit the program without saving the layout.
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Arranging Layouts
Changing the way layouts are presented in the Choose Layout workspace can be helpful if 
there are a large number of layouts and you want to be able to see them more easily.

To arrange layouts:

1.	 From the View menu, select Arrange Layouts. The Arrange Layouts dialog box 
opens.

Figure 9.	 Arrange Layouts Dialog Box

2.	 In the Columns field, click the Up and Down Arrows or enter a value to set the number of 
icon columns to be displayed.

3.	 In the Panel Size field, click the Up and Down Arrows or enter a value to set the relative 
panel size for the display layout.

4.	 Click OK.

Restoring Default Layouts
You can restore the default layouts that were present when you first installed the Quantum 
Control Software. Performing this operation deletes any user-defined layouts.

To restore a default layout, select Default from the Layouts menu.

Communications Setup
Ensure that the serial ports of the computer are correctly configured if:

•	 You are using the Quantum Control Software to control external devices such as source 
switchers

- or -

•	 You wish to remotely control the Quantum System using serial data strings.

To open the Communications Setup workspace:

Click the Communications Setup button on the main application window taskbar 
(see figure 2, D, on page 8). 

The Communications Setup workspace opens (see figure 10 on the next page).
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Figure 10.	 Communications Setup Workspace

The left side of the Communications Setup workspace contains a Devices tree, similar to 
Windows Explorer. There are two main folders:

•	 Serial Devices — Lists any serial device drivers that are currently loaded. Alternatively, 
if no device drivers are found, any available serial (COM) ports detected by the Quantum 
Control Software are listed.

•	 Settings — Allows XML device drivers to be enabled or disabled for serial or Ethernet 
control (see XML Device Drivers on the next page).

The details displayed in the main area of the workspace change according to the type of 
item selected in the device tree.

Configuring Serial Ports
Any unused serial ports (serial ports not used by a device driver) are listed in the Serial 
Devices folder. These can be configured manually as follows:

1.	 Select the appropriate port number (such as COM1 or COM3) in the Serial Devices 
folder of the Devices tree. The Port Settings and Serial Commands sections appear in 
the workspace.

2.	 In the Port Settings panel, adjust the various parameters as required.

3.	 In the Serial Commands panel, selecting the appropriate check box to specify whether 
the port will be used for incoming (input) or outgoing (output) data.

NOTE:	 Only one port can be used for input data and only one for output data. The 
Current Ports panel shows which ports are currently in use. You can use the same 
port for both input and output data. 
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XML Device Drivers
Device drivers are defined by an XML file, located in the following folder on the hard disk of 
the computer:

Windows NT, XP, and 2000:

C:\Program Files\Extron\Quantum Elite\XML\Device Drivers

- or - 

C:\Program Files\Extron\Quantum Connect\XML\Device Drivers 

Windows 7 and 8:

C:\Program Files (x86)\Extron\Quantum Elite\XML\Device Drivers

- or - 

C:\Program Files (x86)\Extron\Quantum Connect\XML\Device Drivers

Contact the Extron S3 Sales & Technical Support Hotline for further advice on creating an 
XML device driver file.

To enable XML device drivers:

1.	 In the Settings folder of the Devices tree, click XML Driver Path. An Enable XML 
Device Drivers check box appears on the right side of the workspace. 

2.	 Select the Enable XML Device Drivers check box to load the device drivers. A dialog 
box opens while the Quantum Control Software loads the drivers. Then, the driver 
names appear in the Ethernet Devices and Serial Devices folders of the Devices tree.

Setting Up Sources
Each source that you need to use in a project must have a corresponding source definition 
within the Quantum Control Software.

A source definition contains full details of the source, such as its signal format (NTSC, PAL, 
RGB, DVI, and so on) and to which input channel on the Quantum processor the source is 
connected.

If you are using an external source switcher (such as to give access to multiple sources on 
one input), the source definition can also include a serial command string used to operate 
the switcher. A separate source definition is required for each of the sources that can be 
connected to the Quantum processor.

NOTE:	 You need to set up communications with a switcher before you can define any 
sources selected via the switcher (see Communications Setup on page 19).

When the Quantum Control Software needs to display a particular source, it uses the 
parameters in the source definition to configure the appropriate input channel for the source. 

Source definitions are created and set up using the Set Up Sources task.

NOTE:	 The Quantum Connect Control Software does not support the use of QGE 100, 
Clock, and picture source types.
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To access the Set Up Sources task:

Click the Set Up Sources button on the main application window taskbar  
(see figure 2, D, on page 8). The Set Up Sources workspace opens.

Figure 11.	 Set Up Sources Workspace

A  All display processors C  Source type

B  Quantum processor D  Source definition

The source explorer tree, in the left panel of the Set Up Sources workspace, shows a list of 
source types supported by the Quantum processor. Source definitions are listed under the 
relevant source type. The source tree expands up to four levels as shown in figure 11. When 
you open the source explorer after creating an entirely new project (or for the first time after 
installation), no source definitions are listed.

Creating Quantum Source Types and Source Definitions
1.	 In the source explorer of the Set Up Sources workspace, right-click Display 

Processors and select the desired option. Available options include:

•	 Create Quantum Sources — This option adds a list of the supported source types 
to the source tree. Then, you need to create source definitions.

•	 Detect Sources — Selecting this option is the easiest method to create source 
types. To detect sources, the Quantum must be connected to a PC with the 
Quantum Control Software installed. The software communicates with the 
processor, detects the number and type of input cards that are present, and 
builds the source type list. If sources are connected to the processor, the source 
definitions are also created.

•	 Update Sources — Selecting this option when the PC is connected to a Quantum 
processor updates the source tree details.

•	 Remove All Devices — Deletes all devices listed under Display Processors. (If no 
devices have been detected, this option is grayed out.)
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2.	 Right-click the appropriate source type heading in the source explorer (RGB, QGE 100, 
Video, and so on) and select Create New Source from the drop-down menu. An empty 
source definition screen opens in the workspace (see figure 11 on the previous page 
for an example of a new video definition).

3.	 In the Source Name field, enter a name for the source.

4.	 If a serial string is required for the source (for instance, to operate an external switcher), 
enter the appropriate control string in the Source Selected TX field.

5.	 In the Parameters panel, enter the required settings for the source. These settings vary 
according to the source type and are detailed in Source Parameters on the next page.

If you click Detect Sources within a source definition, The following dialog box opens:

Figure 12.	 Quantum Source Selection Dialog Box

6.	 Select a source from the list and click OK to create a source definition for it.

Deleting Source Definitions
To delete a single source definition:

1.	 Right-click the appropriate source definition in the source explorer and select Delete 
Source from the drop-down menu.

2.	 In the Delete Source dialog box, click Yes to confirm the deletion.

To delete all source definitions:

Right-click Display Processors in the source explorer and select Remove All Devices 
from the drop-down menu.

Refreshing Source Data
The DVI, HDMI, SDI, and Video source definition windows each contain a Refresh Status 
button. Click this button to update the information displayed for the selected source.
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Source Parameters
This section describes source parameters for each Quantum source type, along with 
functionality descriptions and available options. These parameters are displayed in the Set 
Up Sources workspace when you select a source definition in the source explorer (see 
figure 12 on the previous page).

Source parameters — Composite video and S-video

Click a composite video or S-video source name listed under Video to view the source 
connected to a Quantum Video Input Card.

Figure 13.	 Video Source Parameters

Video or S-video 
Source Parameter

Parameter Value Description

Source Name <Enter name for source> Descriptor to identify the source

Source Type <Read-only field> Displays the type of source.

Source Selected TX <Enter RS-232 string to be 
transmitted to a connected matrix 
switcher>

(Optional) Transmits an RS-232 command to a 
matrix switcher.

ID •	 <Enter source input number>

•	 <Automatically detect source 
input number>

Displays the source input number on the 
Quantum identified by the card slot number 
and card input number.

To detect this value, click the Detect Sources 
button (see Creating Quantum Source 
Types and Source Definitions on page 22).

For example, 5.3 is the source connected to 
input 3 of the card in slot 5.
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Video or S-video 
Source Parameter

Parameter Value Description

Location •	 <Enter IP address>

•	 <Automatically detect IP 
address>

Displays the IP address of the Quantum card 
frame where the source is connected.

To detect the IP address, use the Detect 
Sources button (see Creating Quantum 
Source Types and Source Definitions on 
page 22).

Format •	 <Read-only field>

•	 <Select an option from the  
drop-down list of format types>

This parameter depends on the AutoDetect 
setting.

•	 If AutoDetect is set to True, this parameter 
is read-only, showing the current source 
format as detected by the Quantum 
processor.

•	 If AutoDetect is set to False, you can 
select an available source format.

AutoDetect •	 True: Allows the Quantum processor 
to automatically detect the current 
source type.

•	 False: Allows you to manually select 
the source type from the Format  
drop-down list.

Enables and disables automatic detection of 
the current source type.

Deinterlace •	 1i: Single Field Interpolation

•	 3i: Three Field Interpolation

Sets the deinterlace mode to be applied to the 
source.

See the Quantum User Guide for further 
information about deinterlacing.

Input •	 Auto: Automatically discovers the 
format.

•	 SVideo: Forces S-video mode.

•	 Composite: Forces composite video 
mode.

Sets the input format.

Always On •	 False (default): The source is not 
always displayed.

•	 True: The source is always displayed.

Sets whether the source is always displayed, 
regardless of whether it is locked to a valid 
sync. 

When Always On is set to True, video can be 
seen while VCR sources are being rewound or 
fast-forwarded.
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Source parameters — RGB

Use the RGB source type to view an RGB graphics or HD video source connected to a  
Quantum RGB Input Card.

Figure 14.	 RGB Source Parameters

Parameter 
Group

RGB Source 
Parameter

Parameter Value Description

Source Name <Enter name for source> Descriptor to identify the source

Switch 
Setting

Source Selected 
TX

<Enter RS-232 string to be 
transmitted to a connected matrix 
switcher>

(Optional) Transmits an RS-232 
command to a matrix switcher.

Source 
Properties

Source ID •	 <Enter source input number>

•	 <Automatically detect source 
input number>

Displays the slot and channel 
number of the RGB card in the 
Quantum frame.

To detect this value, click the 
Detect Sources button (see 
Creating Quantum Source 
Types and Source Definitions on 
page 22).

For example, 5.3 is the source 
connected to input 3 of the card in 
slot 5.

Source Location •	 <Enter IP address>

•	 <Automatically detect IP 
address>

Displays the IP address of the 
Quantum card frame where the 
source is connected.

To detect the IP address, use 
the Detect Sources button (see 
Creating Quantum Source Types 
and Source Definitions).
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Parameter 
Group

RGB Source 
Parameter

Parameter Value Description

Source 
Format

Format •	 <Read-only field>

•	 <Select an option from the 
drop-down list of format types>

This parameter depends on the 
AutoDetect setting.

•	 If AutoDetect is selected, this 
parameter is read-only, showing 
the current source resolution 
as detected by the Quantum 
processor.

•	 If AutoDetect is not selected 
(radio button is cleared), you can 
select an available source format.

Colour Space •	 RGB (default): Default mode

•	 Component HD: Option for component 
HD inputs

•	 Component SD: Option for component 
SD inputs

Lets you select the required color 
space.

Auto Detect •	 True (select Auto Detect radio 
button): Allows Quantum processor to 
automatically detect the current source 
type.

•	 False (select Manual radio button): 

Allows you to manually select the 
source type from the Format  
drop-down list. 

Enables and disables automatic  
detection of the current source 
format.

Manual •	 True (select Manual radio button):

Allows you to manually select the 
source type from the Format  
drop-down list. 

•	 False (select Auto Detect radio 
button): Allows the Quantum 
processor to automatically detect the 
current source type.

When this mode is enabled, the 
input mode can be forced to a 
known format.

In addition, new custom input 
modes can be built (see Creating 
a custom input mode on the next 
page).

Adjustments Brightness, 
Contrast

<Enter values for brightness and 
contrast>

Adjusts the brightness and contrast 
of a source

Phase, Pixel 
Clock

<Enter values for phase and pixel 
clock>

Adjusts the sample clock 
parameters. 
Ensure that the Auto Phase check 
box is not selected.

Auto Phase •	 <Select Auto Phase check box>:

Enables Auto Phase and adjusts the 
clock phase automatically.

•	 <Clear Auto Phase check box>:

Disables Auto Phase.

Enables and disables automatic 
adjustment of clock phase.
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Parameter 
Group

RGB Source 
Parameter

Parameter Value Description

Source 
Viewporting

X Pixels, Y 
Pixels,  
H pos, V pos

<Enter values for size (X pixels 
and Y pixels) and position (H pos 
and V pos).

These controls allow a section of the 
captured source to be isolated as a 
viewport. There is only one viewport 
for each input channel.

Image Auto 
Centre

•	 Off: No automatic centering

•	 Once: Centers source image as part 
of the Detect process

•	 Continuous: Continually monitors 
and centers input source

Sets whether to automatically center 
the input source image and at what 
frequency.

Keep Scene <Select Keep Scene check box>: 
Displays the current scene, not the 
source.

<Clear Keep Scene check box>:  
Displays the source on output 1.1.

Sets whether to display the current 
scene or the source.

Creating a custom input mode

To create custom input formats for RGB sources in the Set Up Sources workspace:

1.	 In the source explorer on the Set Up Sources workspace, select an RGB source (or 
create a new RGB source type and definition (see Creating Quantum Source Types 
and Source Definitions on page 22). The definition screen for the selected source 
opens in the workspace (see figure 11 on page 22 for an example). 

2.	 In the Source Format panel, select the Manual radio button (see figure 14 on page 26). 
This disables Auto Detect mode and lets you choose a known source format.

3.	 From the Format drop-down list, select the resolution to use as a starting point.
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4.	 In the Source Format panel of the RGB Set Up Sources dialog box (see figure 14 on 
page 26), click New. The User Custom Input Mode dialog box opens. 

 

Figure 15.	 User Custom Input Mode Dialog Box

5.	 In the Mode Name field of the User Custom Input Mode dialog box (see figure 15), enter 
a name for the custom mode.

6.	 From the Template Format drop-down list, select the desired template for the 
customized format (this should already be selected).

7.	 From the Colour Space drop-down list, select the color space to use (such as RGB, 
Component SD, or Component HD).

8.	 In the Active Area panel, adjust the settings as needed by manually entering values into 
the appropriate fields. Alternatively, click the Up and Down Arrows to adjust the values. 
You can adjust the following settings:

Active Lines			   Active Pixels			   Total Pixels 
First Active Line		  First Active Pixel

9.	 In the Signature Parameters panel, adjust the following settings if needed: 

Total Lines			   Line Period			   VSync Lines 
Sync Polarity		 Interlaced check box

ATTENTION:	

•	 Adjust the parameters in the Signature Parameters panel only if absolutely 
necessary to produce the required image. Changes to these settings may 
affect the reliablility of the Auto Detect feature.

•	 Réglez les paramètres dans la section Paramètres de Signature, seulement 
s’il est absolument nécessaire de montrer l’image requise. Changer ces 
paramètres peut affecter la fiabilité de la fonction « Détection Automatique ».

10.	Click Apply to save the changes and continue making other modifications. Alternatively, 
click OK to save the changes and close the User Custom Input Mode dialog box.
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Editing an input mode

To adjust the settings of custom input modes and existing factory formats: 

1.	 Within the source explorer of the Set Up Sources workspace, select an RGB source (or 
create a new RGB source type and definition (see Creating Quantum Source Types 
and Source Definitions on page 22). The definition screen for the selected source 
opens in the workspace.

2.	 In the Source Format panel, ensure the Manual radio button is selected.

3.	 From the Format drop-down list, select the format to be modified.

4.	 Click Edit. The User Custom Input Mode dialog box opens.

5.	 Adjust the settings as necessary.

6.	 Click Apply to save the changes and continue making other modifications. Alternatively, 
click OK to save the changes and close the User Custom Input Mode dialog box.

NOTE:	 When adjusting input modes provided with this application, you are making 
changes to the original factory formats. Any changes made cannot be undone.

Deleting a custom input mode

To delete a custom format:

1.	 In the source explorer on the Set Up Sources workspace, select an RGB source (or 
create a new RGB source type and definition (see Creating Quantum Source Types 
and Source Definitions). The definition screen for the selected source opens in the 
workspace.

2.	 In the Source Format panel, ensure that the Manual radio button is selected.

3.	 From the Format drop-down list, select the format to be deleted.

4.	 Click Delete. The format is removed from the Format drop-down list and the No 
Format Set option is selected.
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Source parameters — DVI

Use the DVI source type to view a source connected to a Quantum DVI Video Input Card.

Figure 16.	 DVI Source Parameters

DVI Source 
Parameter Parameter Value Description

Source Name <Enter name for source> Descriptor to identify the source

Source Type <Read-only field> Displays the type of source

Source Selected TX <Enter RS-232 string to be 
transmitted to a connected matrix 
switcher>

(Optional) Transmits an RS-232 command to a 
matrix switcher.

ID •	 <Enter source input number>

•	 <Automatically detect source 
input number>

Displays the source input number on the 
Quantum identified by the card slot number 
and card input number.

To detect this value, use the Detect Sources 
button (see Creating Quantum Source 
Types and Source Definitions on page 22). 

For example, 5.2 is the source connected to 
input 2 of the card in slot 5.

Location •	 <Enter IP address>

•	 <Automatically detect IP 
address>

Displays the IP address of the Quantum card 
frame where the source is connected.

To detect the IP address, use the Detect 
Sources button (see Creating Quantum 
Source Types and Source Definitions).

Format <Read-only field> Reports the source resolution as detected by 
the Quantum processor.
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Source parameters — HDMI

Use the HDMI source type to view a source connected to an HDMI Video Input Card.

Figure 17.	 HDMI Source Parameters

HDMI Source 
Parameter Parameter Value Description

ID •	 <Enter source input number>

•	 <Automatically detect source 
input number>

Displays the source input number on the 
Quantum identified by the card slot number 
and card input number. For example, 5.2 is the 
source for input 2 of the card in slot 5.

To find this value, click the Detect Sources 
button (see Creating Quantum Source 
Types and Source Definitions on page 22). 

Location •	 <Enter IP address>

•	 <Automatically detect IP 
address>

Displays the IP address of the Quantum card 
frame where the source is connected.

To detect the IP address, click the Detect 
Sources button.

Format <Read-only field> Reports the source resolution as detected by 
the Quantum processor. Click the Refresh 
Status button to update this field.

HDCP Status <Read-only field> Reports the input HDCP encryption status.  
Click the Refresh Status button to update 
this field.

HDCP Authorized •	 On: Outputs do not display content if 
the system is not fully HDCP-compliant

•	 Off: Video is displayed on all outputs 
despite the system not being fully 
HDCP-compliant

Lets you select whether to enable or disable 
HDCP authorization if the system is not fully  
HDCP-compliant and digital sources need to 
be displayed on all outputs.
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Source parameters — SDI

Use the SDI source type to view a source connected to an SDI Video Input Card.

Figure 18.	 SDI Source Parameters

SDI Source 
Parameter Parameter Value Description

ID •	 <Enter source input number>

•	 <Automatically detect source 
input number>

Displays the source input number on the 
Quantum identified by the card slot number 
and card input number. For example, 4.2 is the 
source for input 2 of the card in slot 4.

To find this value, click the Detect Sources 
button (see Creating Quantum Source 
Types and Source Definitions on page 22). 

Location •	 <Enter IP address>

•	 <Automatically detect IP 
address>

Displays the IP address of the Quantum card 
frame where the source is connected.

To detect the IP address, click the Detect 
Sources button.

Format <Read-only field> Reports the source resolution as detected by 
the Quantum processor. Click the Refresh 
Status button to update this field.

Film Mode •	 Automatic: Detects the presence of a 
film mode cadence (default).

•	 Disabled: No film mode detection is 
performed.

Lets you enable or disable automatic film 
mode detection (PAL, NTSC, and 1080i). 

Deinterlace •	 Enabled: Deinterlaces NTSC, PAL, 
and 1080i sources (default).

•	 Disabled: Deinterlacing is not done. 

Selects whether sources are deinterlaced 
before being placed on the RAPT bus. 
Selecting Disabled saves bandwidth on the 
RAPT bus when deinterlacing is not a priority.
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Source parameters — QGE 100

Use the QGE 100 source type to display a source derived from a QGE 100.

NOTE:	 The Quantum Connect does not support the use of QGE 100 sources.

Figure 19.	 QGE 100 Source Parameters

QGE 100 Source 
Parameter Parameter Value Description

Source Name <Enter name for source> Descriptor to identify the source

Source Type <Read-only field> Displays the type of source

Source Selected TX <Enter RS-232 string to be 
transmitted to a connected matrix 
switcher>

This is optional. Transmits an RS-232 
command to a matrix switcher.

Server <Enter name or IP address of host or 
source computer>

Specifies the network name* or IP address of 
the QGE 100 source

*To use names, the network must support 
DNS (Dynamic Name Services).

For example, to select a QGE 100 source 
called “QGE100” with an IP address of 
178.28.229.101, enter either QGE1ØØ or 
172.28.229.1Ø1.

IPAddress <Enter IP address> Displays the IP address of the QGE 100 where 
the source is connected. 

This field must be left blank if the adapter 
is using DHCP.

Multicast Address <Enter multicast address of the 
connected QGE 100>

If the source is a QGE 100 operating in 
Multicast mode, enter its multicast address 
here.

For example, enter 234.5.6.183.

Multicast Port <Enter multicast port number of the 
connected QGE 100>

The default port is 5000.
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Source parameters — Picture

Use the Picture source type to display an image file (in JPG, GIF, PNG, or BMP format). The 
file can be on the Quantum hard drive (in the d:/pictures folder) or on the network. 

NOTE:	 The Quantum Connect does not support the use of Picture sources.

Figure 20.	 Picture Source Parameters

Picture Source 
Parameter Parameter Value Description

Source Name <Enter name for source> Descriptor to identify the source

Source Type <Read-only field> Displays the type of source

Source Selected TX <Enter RS-232 string to be 
transmitted to a connected matrix 
switcher>

This is optional. Transmits an RS-232 
command to a matrix switcher.

Filename <Enter path and filename of the 
desired image>

Indicates the path and filename of the desired 
image. For example:

•	 To select a file on the Quantum, use the 
format d:/pictures/companylogo.jpg

•	 To select a file on a network computer or 
server, use the format: 
\\imageserver\companylogo.jpg

Location •	 <Enter IP address>

•	 <Automatically detect IP 
address>

Displays the IP address of the Quantum 
card frame where the image file is located. 
To detect the IP address, use the Detect 
Sources button (see Detect Sources on 
page 22).

GraphicsOverlay •	 True: Makes the specified key color in 
the image transparent.

•	 False: Disables transparency (key 
color is opaque).

Makes the specified key color transparent or 
opaque.

KeyColour <Enter three values each, 0 to 255> •	 If GraphicsOverlay parameter is set to 
True, these values set the color in the 
image that will be transparent.  
Example: 0, 0, 255 = Blue

•	 If Graphics Overlay is set to False: these 
values set the red, geen, and blue levels. 

Quantum Control Software • System Configuration 35



Source parameters — Timer

Use the Timer source type to create an on-screen clock or count-down or count-up timer.

NOTE:	 The Quantum Connect does not support the use of Clock or Timer sources.

Figure 21.	 Timer Source Parameters

Timer Source 
Parameter Parameter Value Description

Source Name <Enter name for source> Descriptor to identify the source

Source Type <Read-only field> Displays the type of source

Source Selected TX <Enter RS-232 string to be 
transmitted to a connected matrix 
switcher>

This is optional. Transmits an RS-232 
command to a matrix switcher.

ID <Enter an alphanumeric label> User-defined alphanumeric label (such as the 
source name) that is unique to the project

GraphicsOverlay •	 True: Makes the specified background 
color in the image transparent.

•	 False: Disables transparency 
(background color is opaque).

Makes the background color of the image 
transparent or opaque.

Size •	 Small

•	 Medium (default)

•	 Large

•	 Extra Large

Sets the size of text on the clock or timer 
display.
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Timer Source 
Parameter Parameter Value Description

ForeColour <Enter three values each, from 0 to 
255>

Sets the foreground (text) color for the clock or 
timer display. These values set the red, green, 
and blue levels. For example:

•	 255,255,255 = White (default)

•	 128,0,0 = Mid-red

•	 255,255,0 = Bright yellow

BackColour <Enter three values each, from 0 to 
255>

Sets the background color for the clock or 
timer display. These values set the red, green, 
and blue levels. For example:

•	 0,0,0 = Black (default)

•	 128,0,0 = Mid-red

•	 0,0,75 = Dark blue

Font •	 Arial

•	 Verdana (default)

•	 Microsoft Sans Serif
•	 Tahoma

Sets the font for the clock or timer display

TimeFormat •	 12: Sets 12-hour time format.

•	 24 (default): Sets 24-hour time format.

Sets the time format for the clock or timer 
display

ShowSeconds •	 True: Displays hours, minutes, and 
seconds.

•	 False: Displays only hours and 
minutes.

Displays or hides the seconds in the time.

ShowDate •	 True: Displays the date and time.

•	 False: Displays only the time.

Sets whether to display the date along with the 
time.

DateFormat •	 dd/mm/yyyy (default)

•	 mm/dd/yyy

•	 20 June 2006

•	 June 20 2006

Sets the format to use when displaying the 
date.

ShowWeekDay •	 True: Displays the day of the week 
(Monday to Sunday) and the date

•	 False: Displays only the date

Sets whether to display the day of the week 
along with the date.

TimerStartTime <Enter the time from which the timer 
begins>

When the Quantum is operating in timer mode, 
this value defines the start time in hh:mm:ss. 
The default is 00:00:00.

In countdown mode, when the timer reaches 
zero, the timer reloads with the preset value 
and starts again.

ClockMode •	 Clock (default)
•	 Timer

Selects a standard clock or a timer to display. 

For timer mode, set the TimerCountDirection 
parameter as needed.
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Timer Source 
Parameter Parameter Value Description

TimeZone <Select an option from the drop-down 
list of time zones>

Sets the time zone for the clock and date.

NOTE:	 The time zone that was set on the 
control software PC must match the time 
zone set on the Quantum card frame. 
The default is Greenwich Mean Time 
(GMT), London.

Alignment •	 Left

•	 Center (default)
•	 Right

Sets the horizontal alignment of the text 
relative to the window in which it is placed.

TimerCountDirection •	 Up (default)
•	 Down

When using timer mode, use this parameter to 
set the direction in which the timer will count. 

Defining EDID
EDID information (display resolution, refresh rate, and pixel clock rate), when read from an 
output display or selected by a user, is stored in memory on each input, allowing the source 
to perform as if connected to the display, even when it is not. 

The EDID Minder screen enables you to set the Extended Display Identification Data 
(EDID) for each of the RGB, DVI, and HDMI inputs on the cards installed in your Quantum 
processor. It also provides status on the current EDID resolution that has been set for each 
input. The default EDID setting of 1920x1200 at 60 Hz is used for each input.

Selecting an EDID
To specify a display EDID for an input (see figure 22 on the next page):            

1.	 Click the EDID Minder icon on the taskbar (see figure 2, D, on page 8).                                                   

2.	 In the EDID Minder workspace (right panel), click the Refresh Status of 
Input EDID button. The installed input connectors are displayed in the input 
channel list (left column).

You can sort the input channels on this list by signal type (DVI, HDMI, and RGB), 
connector ID, EDID currently assigned to the input, or IP address of the Quantum 
(Location). Click the desired column heading to toggle between sorting and inverse 
sorting.

3.	 On the channels list, select an input by clicking on its signal type to highlight it. To select 
multiple individual inputs, hold down <CTRL> while clicking each one. To select a group 
of consecutive inputs, hold down <Shift> while selecting the first and last input in the 
range.
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4.	 From the Select EDID Resolution drop-down menu, select the EDID to apply to the 
selected input. The menu contains the following resolutions at 50 Hz and 60 Hz.

Use Display’s EDID* 1280x768 1400x1050

640x480 1280x800 1680x1050

800x600 1280x1024 1600x1200

848x480 1360x768 1920x1080 (1080p)

1024x768 1366x768 1920x1200

1280x720 (720p) 1440x900

*This option does not appear on the menu unless an EDID has been captured from 
  display 1 (see Capturing an EDID (HDMI Displays Only) on the next page.

Figure 22.	 EDID Minder Screen

5.	 Click Apply to Selected. The new EDID appears in the input channels list for the 
selected input. 
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Capturing an EDID (HDMI Displays Only)
An alternative method of assigning an EDID to an input is to “capture” the EDID information 
from the output to which display 1 is connected. 

NOTE:	 Display 1 is the display located at the top left of your selected layout. Click the 
Choose Layout icon on the taskbar to view the current layout. 

For this procedure, display 1 must be connected to a Quantum HDMI output card.

To capture and apply the EDID of display 1 to an input:

1.	 Click the Capture EDID from display #1 button in the EDID Minder workspace. The 
display 1 EDID is displayed in the Preferred Timing of Captured EDID box above the 
button.

2.	 Select an input from the input channels list.

3.	 From the Select EDID Resolution drop-down menu, select Use Display’s EDID.

NOTE:	 This selection may not be available the first time you perform this procedure. 
If it does not appear on the menu, skip this step. The option is added to the menu 
and appears in the Select EDID Resolution box after you capture and apply the 
display 1 EDID.

Example: In figure 23, HDMI input 5.2 has been selected on the input channels list and 
Use Display’s EDID has been selected from the Select EDID Resolution menu. The 
captured display 1 resolution of 1920x1200 @ 60 Hz appears in the Preferred Timing of 
Captured EDID box. The Apply to Selected button has not yet been clicked, so the 
selected input is not shown with the captured EDID. 

Figure 23.	 Capturing the EDID of Display #1

4.	 Click Apply to Selected. The captured EDID of display 1 appears beside the selected 
input on the input channels list. 

NOTE:	 On the EDID Minder input channels list, the asterisk (*) following an EDID 
indicates that the EDID was captured.
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Creating a Project

This section describes the Scene Design task and creating a project using scenes and 
windows. Topics that are covered include:

•	 Working with Scenes

•	 Working with Windows

Working with Scenes
A scene is a preset that contains the size, position, and contents of one or more windows. 
You can create scenes, save them, and recall them to display.

Scene Design Task

Figure 24.	 Main Features and Toolbars of the Scene Design Task

A	 Virtual Display toolbar	 D	 Window Properties toolbar	 G	 Virtual display area	

B	 Window toolbar	 E	 Window palette	 H	 Scene list

C	 Scene toolbar	 F	 Source Explorer	 I	 Scene Control toolbar
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To view a source on the target display, place a window (containing the appropriate source) 
on the display. Windows and scenes are created and edited in the Scene Design task. You 
can store the size, position, and contents of one or more windows as a scene. Each scene 
can have a different arrangement of windows and sources.

To open the Scene Design task: 

1.	 Click the Scene Design button on the taskbar (see figure 2, D, on page 8).        

The Scene Design Workspace opens (see figure 24 on the previous page).

Creating a New Scene
New scenes are added to the end of the scene list. A new scene has no attributes copied 
from the currently selected scene.

NOTE:	 The number of windows allowed within a scene depends on the Quantum 
processor hardware. The maximum is 128 windows per output card. See the Quantum 
User Guide for more details.

To create a new scene:

1.	 Click the  button on the Scene Properties toolbar (see figure 24, C). The Scene 
Properties dialog box opens.

Figure 25.	 Scene Properties Dialog Box

2.	 Modify the default scene title as desired. To change other settings follow the procedure 
described in Changing Scene Properties on the next page.

3.	 Click OK. In the Scene Control workspace, a new Scene Selection button is also 
added for the new scene (see Using the Scene Control on page 61). 

4.	 Add a window to the scene (see Adding Windows to the Window Palette on 
page 48).
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Copying an Existing Scene
You can create an exact copy of any scene that exists in your project. This is useful when 
you are creating a number of scenes that only have slight variations from each other.

The copied scene is inserted immediately after the original scene. It has the same window 
palette, window layout, control commands, and Auto Play settings as the original.

To copy an existing scene:

1.	 In the scene list of the Scene Design workspace, select the name of the scene to be 
copied.

2.	 Click the  button on the Scene Properties toolbar. The Scene Properties dialog 
box opens for the copied scene (see figure 25 on the previous page).

3.	 Modify the default scene title and other settings as needed.

4.	 Click OK. In the Scene Control workspace, a new Scene Selection button is also 
added for the copied scene (see Using the Scene Control on page 61.

Deleting a Scene
1.	 In the scene list of the Scene Design workspace, select the scene to be deleted. The 

selected scene is displayed in the workspace.

2.	 Click the  button on the Scene Properties toolbar. In the Scene Control, the 
corresponding Scene Selection button is also deleted (see Using the Scene 
Control).

Changing Scene Properties

1.	 Select a scene in the scene list of the Scene Design workspace and click the   
button on the Scene Properties toolbar 

- or -

For any scene, right-click the scene title in the scene list.

The Scene Properties  box opens (see figure 25).

2.	 Modify the settings as needed. These settings include:

•	 AutoPlay Delay (mSec) — Set the amount of time that the scene is displayed 
during Auto Play (see Changing the Display Time for a Scene on page 68).

•	 Include Scene in Autoplay — Select this check box to include this scene in an 
AutoPlay project. Clear this check box to exclude the scene (see Changing the 
Display Time for a Scene).

•	 Don’t display windows - send serial strings only — By selecting the Don’t 
display windows check box on the Scene Properties dialog box, only the 
serial strings (if any) associated with the scene are executed. Any source or layout 
changes in the scene are ignored. This allows the scene to transmit a serial 
command without changing the current layout of the target display, such as to 
operate an external source switcher.

3.	 Click OK.
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Scene Commands

Adding a scene command

1.	 Select a scene in the scene list of the Scene Design workspace and click the 
button on the Scene Properties toolbar (see figure 24, C, on page 41)

- or -

For any scene, right-click the scene title in the scene list.

The Scene Properties dialog box opens (see figure 25 on page 42).

2.	 Select the appropriate Scene Commands tab. The available tabs include:

•	 Pre Scene Commands — Commands that occur as soon as the scene is selected 
but not yet fully displayed

•	 Post Scene Commands — Commands that occur when the scene display is fully 
complete

•	 Exit Scene Commands — Commands that occur when another scene is selected 
but before the pre-scene commands of the new scene

NOTE:	 The procedure to add, edit, or remove commands is the same for each tab.

3.	 Click Add to display the Add Command  box.

Figure 26.	 Add Command Dialog Box

4.	 From the Device drop-down list, select the device for which you want to add a 
command.

5.	 In the Commands panel, select the desired command name from the list. 

If you select a non-XML defined serial port (which is shown on the Device list as 
OUTPUT), a text box is displayed for you to enter a free format text string command.

6.	 Click OK to add the command to the scene.
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Changing the order of scene commands

1.	 Select a scene in the scene list of the Scene Design workspace and click the  
button on the Scene Properties toolbar (see figure 24, C, on page 41)

- or -

For any scene, right-click the scene title in the scene list. 

The Scene Properties dialog box opens (see figure 25 on page 42).

2.	 Select the appropriate Scene Commands tab.

3.	 In the command list, select the command to be moved.

4.	 In the Command Ordering panel, click the Move Up or Move Down button to move the 
command to the desired position in the list.

Removing a scene command

1.	 Select a scene in the scene list of the Scene Design workspace and click the  
button on the Scene Properties toolbar (see figure 24, C)

- or -

For any scene, right-click the scene title on the scene list. 

The Scene Properties dialog box opens (see figure 25).

2.	 Select the appropriate Scene Commands tab.

3.	 In the command list, select the command to be removed.

4.	 Click Remove.

Editing a serial (output) scene command

1.	 Select a scene in the scene list of the Scene Design workspace and click the  
button on the Scene Properties toolbar 

- or -

For any scene, right-click the scene title in the scene list. 

The Scene Properties dialog box opens (see figure 25).

2.	 Select the appropriate Scene Commands tab.

3.	 In the command list, select the output name.

4.	 Click Edit.

5.	 Edit the free format text string as needed.

6.	 Click OK.
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Changing the Order of Scenes and Scene Navigation
You can change the order of the scenes in the scene list. When using the Auto Play option, 
scenes are recalled in the order that they appear in this list. You can use the Scene Control 
toolbar, scene list, and keyboard to navigate to the scene you want to view or edit. To move 
a scene in the scene list, drag and drop the scene title to a new position in the scene list 
(see figure 24, I, on page 41).

To go to... Click...

A specific scene The scene title in the scene list

The next scene
The  button or press the <Down Arrow> key on the keyboard

The previous scene
The  button or press the <Up Arrow> key on the keyboard

The first scene
The  button or press the <Home> key on the keyboard

The last scene
The  button or press the <End> key on the keyboard

The Play button  plays all the scenes in order in a loop until the Stop  button is 
clicked.

Working with Windows
In the Scene Design workspace, the target display is represented by the virtual display area 
and each window that can be placed on the display is represented by a virtual window (see 
figure 24, G). Each window that appears on the display has a source associated with 
it. On the Scene Design page, you can create windows and add them to the display as 
desired. The contents of each window can be the same or can differ between scenes. 

When you create a window, it is added to the window palette, located between the taskbar 
and the source explorer panels on the Scene Design page. You can drag windows from the 
palette to the Scene Design workspace and place them where desired on the display.

NOTE:	 The window palette may not be visible when you open the Scene Design 
workspace. To display it, drag the left edge of the source explorer panel to the right 
until the palette appears.
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Each virtual window has a unique number (automatically assigned by the Quantum Control 
Software) and a user-definable label that is typically used to identify the source. 

AA

��

Figure 27.	 Virtual Window with Label

A	 Window number

B	 Window label

The appearance of a window in the window palette differs depending on whether the 
window is docked (not used in the scene) or undocked (used in the scene). If the window 
is undocked, it has a light gray border (see figure 28). All windows that have been added to 
the virtual display have this border. Docked windows exist only in the window palette.

Figure 28.	 Docked and Undocked Windows in the Window Palette

When you hover the mouse pointer over a window in the palette, a pop-up opens showing 
the window number and its source type. For example:

Figure 29.	 Window Details Pop-up
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Adding Windows to the Window Palette
When you create a new project, the window palette is empty and you need to add windows 
to it. The methods of adding windows are described in the following sections.

Creating a window with a source

This method is the simplest and therefore recommended. To create a window with a source 
displayed:

1.	 Click on a source name in the Source Explorer tree and drag it to the desired location in 
the virtual display area (see figure 24, F, on page 41). A window with the source 
selected appears in the workspace and on the palette. The size of the window matches 
the current grid spacing.

NOTE:	 Windows created by this method appear in the workspace and 
on the window palette with the source icon (shown at right) because 
they already have sources selected.

2.	 Resize or move the window on the palette as desired (see Moving and Resizing a 
Window on page 50. 

Creating an empty window

If you have not determined the source you want to display in a window, or the source has 
not been added to the Source Explorer, you can create an empty window and add the 
source to it later (see Adding or Changing a Source for a Window on the next page). 

You can create a window without a source in either of the following areas:

•	 Window palette: Right-click anywhere in the window palette, then click the Add 
Window pop-up. A new window is added to the window palette and is given the next 
available window number. 

•	 Virtual display: Right-click anywhere in the virtual display or workspace (but not in an 
existing window), then select Add Window from the drop-down menu. A new window is 
both added to the window palette and placed in the workspace area.

Initially, each window created by this method has a pink background (see figure 29 on the 
previous page), which indicates that no source is selected for the window. 

Adding a Docked Window to a Scene
To add a docked window in the window palette to a scene:

1.	 In the window palette, select the window to be added to the current scene. The window 
is outlined in red.

2.	 Drag the window into the virtual display area. The light gray border is added to the 
window on the window palette.

3.	 Modify the window as desired (see Selecting the Window Style (Quantum Elite 
Models Only) on page 52).
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Adding or Changing a Source for a Window
To select or change a source for a window on the virtual display, use one of the following 
procedures.

•	 Right-clicking and dragging: In the Source Explorer, right-click on the desired source 
and drag it onto a window in the virtual layout (see figure 24, G, on page 41). 

If the window already has a source, the source you are dragging replaces it. If the 
window has no source, the selected source is added to it. A light gray border appears 
around the window on the window palette to indicate that it has a source.

•	 Using the Quantum Sources window:  

1.	 Select a window in the window palette or in the virtual display area of the currently 
selected scene.

2.	 Right-click the selected window and select Window Source from the drop-down 
menu. The Quantum Sources dialog box opens.

Figure 30.	 Quantum Sources Dialog Box

3.	 In the Sources panel of the dialog box, select the desired source. You can filter the 
listed sources by selecting an option from the View By or Category  
drop-down lists. You can also search for sources using the Search field.

NOTE:	 The Search field is case-sensitive.

4.	 Click OK.
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Deleting a Window
To remove a window from the scene or the window palette:

1.	 In the window palette or in the virtual display area, select the window to be removed 
from the currently selected scene.

2.	 Do one of the following:

•	 Press the <Delete> key on your keyboard.

•	 Right-click on the window and select Delete Window from the drop-down menu.

•	 Click the  button on the Window Properties toolbar. 

Moving and Resizing a Window
The simplest way to resize and reposition a window is to use the dragging procedure 
described below. To perform finer adjustments to the size and placement of the window, see 
Using the Window Properties toolbar or Using the Window Size & Position dialog 
box on the next page.

To move or resize a window in the virtual display area:

1.	 Select a window in the virtual display area or select an undocked window in the 
window palette of the currently selected scene. In the virtual display area, the window is 
highlighted as shown below:

Resizing Handles

Figure 31.	 Selecting a Window

2.	 Perform the following as needed:

•	 To resize the window, drag one of the resizing handles on the window border 
until the window is the desired size. The mouse pointer changes to a double arrow 
symbol, showing which direction the border can be moved.

To size the window to fit the entire display array, right-click the window and select 
Full Screen from the drop-down menu.

•	 To move the window, click the window and drag it to a new location. The mouse 
pointer changes to two crossed arrows while hovering over the selected window.

With the layout grid turned on, window borders automatically align or snap to the grid lines. 
You can temporarily disable this feature by holding down the <Shift> key on your keyboard 
while moving or resizing the window.

If necessary, you can hide the layout grid or change its spacing (see Changing the Virtual 
Display Properties on page 59).
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Using the Window Properties toolbar

If you need to position or resize a window with pixel accuracy, you can use the Window  
Properties toolbar (see figure 24, D, on page 41), as follows:

1.	 If the Window Properties toolbar is not currently displayed, select Window Properties 
Toolbar from the View menu. A check mark appears in front of the menu option and 
the following toolbar is displayed:

Figure 32.	 Window Properties Toolbar

2.	 In the virtual display area, click on the window to be adjusted.

3.	 On the Window Properties toolbar, click the H Position and V Position Arrows to 
adjust the window position, or enter positive or negative pixel values in the H Position 
and Y Position fields and press <Enter> on your keyboard.

4.	 Click the Width and Height Arrows to adjust the window size, or enter pixel values in 
the Width and Height fields and press <Enter> on your keyboard.

Using the Window Size & Position dialog box

If you need to position or resize a window with pixel accuracy, you can use the Window  
Size & Position dialog box.

1.	 Right-click a window in the virtual display area of the currently selected scene and 
select Adjust Position and Size from the drop-down menu. The Window Size & 
Position dialog box opens.

Figure 33.	 Window Size & Position Dialog Box

2.	 Set the Variable aspect ratio check box as needed.

•	 Cleared — The vertical and horizontal sizes are locked together. The viewport 
maintains the aspect ratio of the original source.

•	 Selected — The vertical and horizontal size can be adjusted independently.

3.	 Click the Position Arrows to adjust the window position or enter pixel values in the 
X (left edge) and Y (top edge) fields.

4.	 Click the Width and Height Arrows to adjust the overall window size or enter pixel 
values in the W (width) and H (height) fields.
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5.	 To set the actual source element to a specific size (rather than the overall window size), 
click the Size Arrows to make the necessary adjustments. 
Width and height values in the Source Window Size panel show the size of the source, 
allowing for the width of any border or title text (see figure 34).

Figure 34.	 Example of Window Sizing

6.	 Click Apply to update the display with the new settings and leave the dialog box open. 
Click OK to save the new settings and close the dialog box or click Cancel to keep the 
existing settings.

Selecting the Window Style (Quantum Elite Models Only)

NOTE:	 The Quantum Connect Control Software does not support the use of window 
styles.

Using the Quantum Elite, you can give each window a text label to identify the source on the 
target display and a colored border if desired. Two types of text labels can be applied to a 
window:

•	 Overlay text — Text is placed over the source.

•	 Title text — Text is placed above or below the source on a colored background.

The appearance of window text and borders is defined by a style. A style specifies the font, 
size, color, and position of label text, as well as border width and color. Figure 35 on the 
next page shows examples of different window styles.

By default, if a style that adds a border or title text is applied to a window, the overall 
window size does not increase. The window source is scaled down to allow the border or 
title text to fit within the same overall window size.

If you want the source to remain a specific size, manually set it to the required size using the 
Window Position dialog box (see Moving and Resizing a Window on page 50 for more 
information).

NOTE:	 Window styles are defined in an XML file called ESQuantumConfig.xml. To 
change or add to the default styles provided in this version of the Quantum Control 
Software, you can edit the parameters of this file (see Modifying Window Styles on 
page 84).
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Figure 35.	 Examples of Different Window Styles
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Changing the window style

To change the window style:

1.	 In the window palette or in the virtual display area of the currently selected scene (see 
figure 24, E or G, on page 41), select a window.

2.	 Right-click the window and select Window Properties from the drop-down menu. The 
Set Window Properties dialog box opens.

3.	 Select the Window Styles tab and choose a style from the Styles list:

Figure 36.	 Window Styles Dialog Box

The Title Text Preview and Overlay Text Preview sections of this tab show the appearance 
of text for the selected style. Selecting None produces a plain source window with no 
border or title text.

NOTE:	 Only the size, font, and position of the label text and the size of the window 
border are reflected on the virtual display. The text and border colors can be 
viewed only in the Preview panel of the Window Styles dialog box and on the 
actual display.
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Changing the window text

To change the text content of the window label:

1.	 In the window palette or in the virtual display area of the currently selected scene, select 
a window.

2.	 Right-click the window and select Window Properties from the drop-down menu. 
The Set Window Properties dialog box opens (see figure 37).

Figure 37.	 Window Text Dialog Box

NOTE:	 The content of text labels and overlays can be viewed only on the display.

3.	 Select the Window Text tab and enter the desired text in the Title Text and Overlay 
Text fields.

NOTE:	 If the Title Text field is empty, the source name is displayed as the title 
text. If the Overlay Text field is empty, no overlay text is displayed.

4.	 When finished entering properties on both tabs, click OK to close the window and 
implement your changes.

Changing the Zoom Properties
By default, a window that contains a source displays the entire source frame. The source 
is automatically scaled to fit within the window. However, if needed, you can zoom into any 
part of the source frame, such as to exclude unwanted or irrelevant material.

The portion of the image that you can zoom into is called a “viewport” (see the example in 
figure 38 on the next page). A viewport can:

•	 Be as small as 6 percent of the active source frame.

•	 Have the same aspect ratio as the source or be stretched in either the horizontal or 
vertical direction.

•	 Be positioned (or panned) to view any part of the source frame.
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Regardless of the size, shape, or position of the viewport, the portion of the source image 
that it contains fills the entire window (see figure 38).
Original Source

Viewported 
Source

Figure 38.	 Example of a Standard Viewport that Preserves the Aspect Ratio of the 
Original Source 

If the window does not have the same aspect ratio as the original source, the viewported 
image is compressed or stretched to fit the window (see figure 39). To retain the aspect ratio 
of the viewport, the window needs to be the same shape as the viewport.
Original Source

Viewported 
Source

Figure 39.	 Example a Stretched Viewport 
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The number of viewported windows that can be present within one scene is dependent on 
source types as well as the size and shape of the windows.

NOTE:	 Zooming in on part of a source only enlarges the image detail that is already 
present in the source signal. If the image detail is not of good quality, zooming in does 
not increase the level of detail.

To change the viewport:

1.	 Right-click the window in the virtual display area (see figure 24, G, on page 41) and 
select Zoom Properties from the drop-down menu. The Source Properties dialog 
box opens. 

 

Figure 40.	 Source Properties Dialog Box

2.	 Set the Variable aspect ratio check box as needed.

•	 Cleared — The vertical and horizontal zoom percentages are locked together. The 
viewport maintains the aspect ratio of the original source.

•	 Selected — The vertical and horizontal zoom percentages can be adjusted 
independently.

3.	 Select fine or coarse adjustment by clicking the appropriate radio button (Fine or 
Coarse).

4.	 Click the Zoom/Stretch Arrows to change the size of the viewport 

- or - 

Click and drag the handles of the viewport area to adjust the size.

To quickly return the Zoom and Stretch settings back to 100 percent (no viewport), click 
Reset.

5.	 Click the Pan Arrows to change the position of the viewport

- or - 

Click and drag the viewport area to the desired position.

The target display updates in real time as you make changes to the zoom and pan 
settings.

6.	 Click OK to accept the new viewport settings or click Cancel to retain the previous 
settings.
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Changing the Layer of a Window
The layer of a window determines whether it appears in front of or behind other windows. 
Only one window can exist on a layer. A layer is also known as a Z order or priority.

Layers are identified by a number and the higher the number, the further forward the 
window. For example, a window on layer 3 appears in front of a window on layer 2, but 
behind a window on layer 4. The farthest back is layer 0.

To see the current layer number of a window, hover over the window in the window palette. 
A pop-up opens showing the window number, its current layer, and source type.

NOTE:	 The maximum number of windows allowed within a scene is dependant on the 
Quantum processor hardware. The maximum is 128 windows per output card (see 
the Quantum User Guide for more information).

To change the layer:

1.	 Select a window in the window palette or in the virtual display area of the currently 
selected scene.

2.	 Using the Window Properties toolbar, click one of the following buttons to change the 
layer of the window. You can also use the Window menu to change the layer.

Buttons and Menu Options Window Movement

Click 

- or - 

From the Window menu, select 
Send Back.

Send backward by one layer.

Click 

- or -

From the Window menu, select 
Bring Forward.

Bring forward by one layer.

Click 

- or -

From the Window menu, select 
Send to Back.

Send to the back of all layers 
(such as layer 1).

Click 

- or -

From the Window menu, select 
Bring to Front.

Bring to the front of all layers.
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Changing the Virtual Display Properties
Various properties of the virtual display area can be altered based on personal preference or 
to assist in creating scenes in the Scene Design workspace. Most of these properties can 
be changed using the Virtual Display Properties toolbar (see figure 24, A, on page 41).

Layout grid

The layout grid in the Scene Design workspace assists you in accurately placing windows 
on the target display. When the grid is visible, the borders of all windows snap to the grid. 

NOTE:	 When the grid is hidden, the snap to grid feature is disabled.

You can change the following grid properties:

•	 To show the grid:

Click the  button

- or -

From the Grid menu, select Snap Grid. A check mark appears on the menu in front of 
the option. This option is listed when no grid is visible.

•	 To hide the grid:

Click the  button

- or -

On the Grid menu, deselect Snap Grid. 

•	 To temporarily disable the snap to grid feature:

Hold down the <Shift> key while placing or resizing the window. 

You can change the number of vertical and horizontal lines in the layout grid.

•	 To increase the number of grid lines:

Click the  button

- or -

Press the <Page Down> key.

•	 To decrease the number of grid lines:

Click the  button

- or -

Press the <Page Up> key.
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Virtual display zoom

You can zoom in on the virtual display area to assist with accurately placing windows or you 
can zoom out to see more of the target display (see figure 24, A, on page 41).

•	 To zoom in on the display:

Click the  button

- or -

From the View menu, select Zoom In

- or - 

Press the <+> key.

•	 To zoom out of the display:

Click the  button

- or - 

From the View menu, select Zoom Out

- or - 

Press the <-> key.

NOTE:	 Zooming in on or out of the virtual display does not affect the content of the 
real display.

Background color

In the virtual display area, you can change the color of the background and the virtual 
display itself (see figure 24, G).

NOTE:	 Changing the color of the virtual display has no effect on the content of the real 
display.

To change the background or virtual display color:

1.	 Right-click anywhere in the layout area (but not on a window) of the Scene Design 
workspace and select either Change Background Color or Change Virtual Display 
Color from the drop-down menu. The Color dialog box opens.

2.	 Select a predefined or newly defined color.

3.	 Click OK.
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Viewing a Project

This section describes the Scene Control task and procedures for setting views of scenes in 
a project. Topics that are covered include:

•	 Using the Scene Control

•	 Using Auto Play

Using the Scene Control
The Scene Control task lets you recall specific scenes in your project by clicking a scene 
control button on the computer screen. The layout and design of the buttons can be 
customized to suit the end user. 

To access the Scene Control:

1.	 Click the Scene Control button on the main application window taskbar  
(see figure 2, D, on page 8). 

The Scene Control workspace and Views toolbar open. 

2.	 If the Views toolbar does not open, select its name from the Views menu.

Run View and Design View
There are two modes for viewing the Scene Control workspace:

•	 Run view

•	 Design view

To change modes, click the Toggle Design/Run Modes button on the Views  
toolbar. 

Run view

In run view mode, the Scene Selection buttons are active. To recall a scene, click the 
appropriate Scene Selection button.

Here is an example of the Scene Control workspace in run view:

Figure 41.	 Scene Control Workspace in Run View
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Design view

In design view mode, you can customize the layout and design of the Scene Selection 
buttons. To assist with button sizing and positioning, a layout grid is displayed. 

Here is an example of the Scene Control workspace in design view:

Figure 42.	 Scene Control Workspace in Design View

Full Screen Mode
The Scene Control task can also be operated in full screen mode, in which only the 
workspace area, which contains the Scene Selection buttons, is visible.

When full screen mode is active, the Scene Control automatically switches to run view 
and access to all setup tasks is disabled. This mode is useful when the Quantum Control 
Software will be controlled via a touch screen.

•	 To activate full screen mode from the Scene Control task, click the  button on the 
Views toolbar.

•	 To return to normal screen mode, press the <Esc> key on your keyboard.

Starting up in full screen mode

The Quantum Control Software can also open directly to full screen mode at startup. To do 
this, create a Windows shortcut and specify a “switch” on the command line.

To start the Quantum Control Software in full screen mode:

1.	 Minimize (or close) the Quantum Control Software and any other Windows applications 
so that you can see the desktop.

2.	 Create a new shortcut by right-clicking the desktop and selecting New > Shortcut from 
the drop-down menu. The Create Shortcut dialog box opens.

3.	 Enter the command line. You can enter the path to the program or locate it by clicking 
the Browse button. In a typical installation, the command line is: 

Windows NT, 2000, and XP: 
C:\Program Files\Extron\Quantum Elite\Quantum Elite.exe or 
C:\Program Files\Extron\Quantum Connect\Quantum Connect.exe.

Windows 7 and 8:

C:\Program Files (x86)\Extron\Quantum Elite\Quantum Elite.exe or 
C:\Program Files (x86)\Extron\Quantum Connect\Quantum Connect.exe.
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4.	 Select the mode in which to open the application by adding one of the following to the 
command that you entered in step 3:

•	 For user mode: Add a space followed by-u to the end of the command line.

•	 For administrator mode: Add a space followed by -f at the end of the 
command line.

5.	 Click Next.

6.	 Enter the name for the shortcut or accept the default name and click Finish.

7.	 If you want the new shortcut to execute when the operating system starts, copy or 
move the shortcut to the Windows Startup folder. See the Windows Help system for 
more information on how to do this.

Creating a Default Layout
You can have the Quantum Control Software create a default layout, comprised of a button 
for each scene in your project. Generally, this function is used to create a new layout and 
customize the layout as needed. Any customized settings that you have already created are 
lost by using this function. To create a default layout:

1.	 Ensure that the Scene Control workspace is in Design View (the layout grid is visible).

2.	 Click the  button on the Views toolbar. A Warning dialog box opens with a 
reminder that any existing layout settings will be lost if you proceed.

3.	 In the Warning dialog box, click Yes to create a default layout or No to retain the 
existing one. 

Customizing the Layout

Changing background properties

You can set the background of the Scene Control workspace to be a solid color or a bitmap 
image. To change the background:

1.	 Ensure that the Scene Control workspace is in Design View (with the layout grid visible).

2.	 Right-click anywhere on the workspace background (but not on a Scene Selection 
button). The Background Properties dialog box opens.

 

Figure 43.	 Background Properties Dialog Box
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3.	 Apply a solid color or a bitmap image. 

•	 To apply a solid color:

a.	 In the Background Properties dialog box, click Colour. The Color dialog 
box opens.

b.	 Select a predefined color from the Basic Colors palette or define a custom 
color.

c.	 Click OK. This returns you to the Background Properties dialog box.

d.	 Click OK on the Background Properties dialog box to apply the chosen color.

•	 To apply a bitmap image:

a.	 In the Background Properties dialog box, click Bitmap Manager. The 
Bitmap Manager dialog box opens.

b.	 In the Available Bitmaps list, select an image name. If there are no bitmaps 
listed or to add a new bitmap, see Using the Bitmap Manager on page 66.

c.	 Click OK to return to the Background Properties dialog box.

d.	 Click OK on the Background Properties dialog box to apply the chosen 
image.

Moving and resizing a button

1.	 Ensure that the Scene Control workspace is in Design View (with the layout grid visible).

2.	 Click a Scene Selection button. It is highlighted with a dotted outline and resizing 
handles.

Figure 44.	 Selecting a Scene Selection Button

3.	 Move and resize the button as needed. 

•	 To resize the button, position the mouse pointer over one of the resizing handles 
and drag the button border to the desired position. The mouse pointer changes to 
a double arrow symbol, showing which direction the border can be moved.

•	 To move the button, position the mouse pointer within the button, hold down 
the left mouse button, and drag the button to a new location. The mouse pointer 
changes to a crossed arrow symbol.

By default, the button borders snap to the layout grid. You can temporarily disable grid snap 
by holding down the <Shift> key on your keyboard while moving or resizing the button.

Changing the properties of a button

You can set the button background to be a solid color or bitmap image. You can also 
change the text displayed on the button, including the font style, size, and color. 

To open the Change Button Properties dialog box:

1.	 Ensure that the Scene Control workspace is in Design View (with the layout grid visible).

2.	 Right-click the Scene Selection button. The Change Button Properties dialog box 
opens (see figure 45 on the next page).
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Figure 45.	 Change Button Properties Dialog Box

To change the text and font displayed on the button:

1.	 In the Button Text field of the Change Button Properties dialog box, enter the 
desired text.

NOTE:	 When the button is first created, the button text is copied from the scene 
title. Any subsequent change to the scene title does not update the text.

2.	 Click Font to change the size, style, or color of the font. The Font dialog box opens.

3.	 Change the font settings as desired.

4.	 Click OK to return to the Change Button Properties dialog box.

5.	 Click OK to apply the new text and font settings.

To apply a solid color to the button:

1.	 In the Change Button Properties dialog box, click Color. The Color dialog box 
opens.

2.	 Select a predefined color from the Basic Colors palette or define a custom color.

3.	 Click OK to return to the Change Button Properties dialog box.

4.	 Click OK to apply the selected color.

To apply a bitmap image to the button:

1.	 In the Change Button Properties dialog box, click Bitmap Manager. The Bitmap 
Manager dialog box opens.

2.	 In the Available Bitmaps list, select an image name. If there are no bitmaps listed or to 
add a new bitmap, see Using the Bitmap Manager on the next page.

3.	 Click OK to return to the Change Button Properties dialog box.

4.	 Click OK to apply the selected image.

TIPS:	

•	 The edge color of a button is determined by the color applied to the entire button 
and remains visible when an image is used. 

•	 To improve the appearance of the button, first apply a color to the button that 
matches the color of the image, then apply the image. 

If you want to hide the button during Run View, select the Hide? check box in the Change 
Button Properties dialog box.
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Changing the properties of multiple buttons

You can change certain properties (such as color and font size) of more than one button 
simultaneously; however, you cannot move or resize several buttons at the same time. To 
simultaneously change the properties of multiple buttons:

1.	 Ensure that the Scene Control workspace is in Design View (with the layout grid visible).

2.	 In the workspace, ensure that the mouse pointer is not over a Scene Selection 
button, then click and drag to draw a rectangle around the buttons you want to change. 
When you release the mouse button, all Scene Selection buttons within the rectangle 
are selected (with resizing handles).

3.	 Right-click on a button, if you want to copy the properties from that button

- or -

Right-click anywhere else in the workspace, if you want to obtain the default properties. 

The Change Button Properties dialog box opens and Multiple selection is shown 
in the preview panel.

4.	 In the Change Button Properties dialog box, make the necessary modifications to the 
font color, font typeface, button color and image.

NOTE:	 You cannot change the button text when selecting multiple buttons.

5.	 In the Change Button Properties dialog box, click OK to apply the new properties to 
all buttons in the selection.

Using the Bitmap Manager
Clicking Bitmap Manager in either the Background Properties dialog box or the Change 
Button Properties dialog box opens the Bitmap Manager dialog box.

 

Figure 46.	 Bitmap Manager Dialog Box

Bitmaps (BMP files) that are applied to the buttons or background of the Scene Control 
workspace are not saved with the project file. Instead, these files are copied to a separate 
folder on the hard drive from which the Quantum Control Software accesses them. 

NOTE:	 If you copy a project from one computer to another, you must remember to copy 
the bitmaps as well.
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Any missing bitmaps are indicated on the appropriate button or background with a red X on 
a blue background as shown below.

Figure 47.	 Missing Bitmap

To change the bitmap folder:

1.	 In the Bitmap Folder field of the Bitmap Manager dialog box, click Browse. The 
Browse for Folder dialog box opens.

2.	 Select the appropriate folder.

3.	 Click OK.

To select an existing bitmap:

1.	 In the Available Bitmaps list of the Bitmap Manager dialog box, select the appropriate 
file.

2.	 Click OK.

Adding, removing, or restoring a bitmap

To add a new bitmap:

1.	 In the Bitmap Manager dialog box, click Add Bitmap. The Open dialog box appears.

2.	 Locate the desired bitmap (BMP) file.

3.	 Click OK. The bitmap file is copied to the directory specified in the Bitmap Folder field 
and appears on the Available Bitmaps list.

You can also copy files directly to the Bitmap folder using Windows Explorer. However, 
you need to close the Bitmap Manager dialog box and reopen it to update the Available 
Bitmaps list.

When the Quantum Control Software is first installed, the default location for storing bitmaps 
is:

C:\Program Files (Program Files (x86) for Windows 7 and 8)\Extron\Quantum 
Elite\Bitmaps

 - or - 

C:\Program Files (Program Files (x86) for Windows 7 and 8)\Extron\Quantum 
Connect\Bitmaps.

To remove a bitmap:

1.	 From the Available Bitmaps list of the Bitmap Manager dialog box, select the file to be 
deleted.

2.	 Click Remove Bitmap. 

If the file is currently in use, a Warning dialog box opens asking whether to delete the 
file. Click Yes to proceed. 

The file is deleted from the list and the bitmap folder. If the bitmap was in use by any 
buttons, those buttons now display a red X on a blue background (see figure 47). 
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To restore a deleted bitmap:

•	 Follow the instructions for adding a new bitmap (see To add a new bitmap 
on the previous page). If the file name of the restored bitmap is the same as the missing 
bitmap, the image is restored to the appropriate button or background.

- or - 

•	 Copy the missing file to the bitmap folder using Windows Explorer. You must restart the 
Quantum Control Software to fully restore the bitmap image to the appropriate button or 
background.

Using Auto Play
When using the Auto Play function, the Quantum Control Software displays each scene 
for a specified period, then switches to the next scene. The period of time that a scene is 
displayed can be different for each scene.

When the project starts, it plays continuously until it is stopped. When the last scene is 
reached, Auto Play cycles back to the first scene.

To use Auto Play, click the Scene Design button on the taskbar (see figure 2, D,  
on page 8 and Taskbar on page 9) to open the Scene Design task. The Scene 
Design workspace opens.

The main features and toolbars associated with the Scene Design workspace are shown in 
figure 24 on page 41.

Changing the Order of Scenes
In an Auto Play project, scenes are recalled in the order that they appear in the scene list on 
the Scene Design workspace.

To move a scene on the scene list, drag and drop the scene title to a new position in the list 
(see Working with Scenes on page 41).

Changing the Display Time for a Scene
Using the Scene Properties dialog box, you can choose whether or not a scene is 
included in an Auto Play project and the length of time that it is displayed. To change the 
display time:

1.	 Click the Scene Design button on the taskbar. The Scene Design workspace  
opens (see figure 24).

2.	 For the currently selected scene in the scene list, click the  button on the Scene 
toolbar 

- or -

For any other scene, right-click a scene title in the scene list.

The Scene Properties dialog box opens. Ensure that the Properties tab is selected 
(see figure 25 on page 42).

3.	 Modify the Auto Play Delay (mSec) setting, the Include Scene in Autoplay 
setting, and other settings as needed. The value in the Auto Play Delay (mSec) field 
is the amount of time that the scene is displayed in a project. The Include Scene in 
AutoPlay check box, if selected, includes the scene in an Auto Play project.

4.	 Click OK.
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Starting and Stopping the Project
To start (play) the project:

1.	 Click the Scene Design button on the taskbar (see figure 2, D, on page 8  
and Taskbar on page 9). The Scene Design workspace opens (see figure 24 
on page 41). 

2.	 Click the  button on the Scene Control toolbar. The Autoplay mode dialog box 
opens while Auto Play is active:

Figure 48.	 Autoplay Mode Dialog Box

The project plays continuously until it is stopped. When the project reaches the last scene, 
Auto Play returns to the first scene.

To stop the project:

Click the  button on the Scene Control toolbar. 

Changing the Playback Speed
When using Auto Play, the duration of displaying each scene is controlled by the Auto Play 
Delay setting in the Scene Properties dialog box (see Changing the Display Time for a 
Scene on the previous page). However, it is possible to speed up or slow down the rate of 
display across the entire project.

To change the playback speed:

Use the following buttons on the Scene Properties toolbar in the Scene Design task:

Button Function

Increases playback speed. Each click decreases the normal delay time* of 
each scene by 10 percent, thus increasing playback speed.

Decreases the playback speed. Each click increases the normal delay 
time* of each scene by 10 percent, thus decreasing the playback speed.

*The normal delay time is defined by the Auto Play delay value on the Scene Properties 
screen.

The current Auto Play time adjustment is displayed on the status bar, with the normal speed 
being 100 percent. For example:

Figure 49.	 Scene Delay Information on the Status Bar
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Serial Commands

This section describes the format of the serial data strings that can be transmitted or 
received by the Quantum Control Software. Topics include:

•	 Control of External Devices

•	 Remote Control of a Project

•	 Command Table

•	 ASCII Character Chart

Control of External Devices
To enable the control of external devices, those devices need to be connected to the Data 
Tx output of the computer serial (RS-232) port.

The serial ports are usually identified as COMn, where n is a number from 1 through 4 (for 
example, COM2). You must ensure that the appropriate serial port is configured correctly by 
following the instructions in Communications Setup on page 19.

Serial data strings can be included within scenes (see Scene Commands on page 44). In a 
scene, three strings can be transmitted:

•	 Pre Scene Commands — Commands that are performed as soon as the scene is 
selected but not yet fully displayed.

•	 Post Scene Commands — Commands that are performed when the scene display is 
fully complete.

•	 Exit Scene Commands — Commands that are performed when another scene is 
selected but before the pre-scene commands of the new scene.

These commands can be used to control external source switchers or other RS-232 
controllable devices.
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Format of External Control Strings
The exact content of the serial data string depends on the device you are controlling. See 
the device user guide for information on supported commands.

A serial data string can comprise of ASCII text, hexadecimal data, and control characters. 
Pauses can also be inserted as necessary to adjust the timing of the messages (see the 
chart below).

Data String
Transmitted 
Information

Text characters using the computer keyboard Text Character

A caret (^) followed by the control character

Example: ^M effectively sends a “carriage return.” For letters, 
use only uppercase characters.

Control Character

The hex pair preceded by a caret (^) and an “at” sign (@)

Example: ^@4B^@24 transmits hex 4B and hex 24 (ASCII 
characters K and $)

Hex Data

A caret (^) followed by a comma. This delays transmission 
of subsequent characters in the string by 100 milliseconds. 
Pauses can be stacked to create longer delays.

Example: ^,^,^,^,^, gives a delay of 500 milliseconds 
(0.5 seconds).

A Pause

Examples of external control strings

Example 1: AUXB12^M

Transmits AUXB12 out of the serial port and terminates with a ^M (carriage return).

Example 2: ^@C0^@00^@02^@00^@15^,^,^,2!^C

Transmits the hex characters C0 00 02 00 15, pauses for 300 milliseconds, and then 
sends the ASCII character 2! followed by a ^C (break).

NOTES:	

•	 Most devices expect some kind of termination character at the end of a control 
string. ^C (break) or ^M (carriage return) are used most frequently. However, this is 
dependant on the hardware you are controlling. There is no standard for termination 
characters.

•	 Any spaces entered within the data string are transmitted just like any other 
character. Therefore, avoid entering or leaving spaces in a data string unless they 
are specifically required by the receiving device. 
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Remote Control of a Project
Remote control of a project is achieved by sending R-type messages to the Data Rx input 
on one of the serial (RS-232) ports of the computer.

Alternatively, R-type messages can be created as simple ASCII text strings and transmitted 
using suitable software, such as a terminal emulation program or a control system.

You can use the external control capability of a project. See Control of External Devices 
on page 70 for information about remotely controlling another project running on a different 
computer.

R-type Message Format
The standard R-type message structure is shown below with examples in ASCII format, 
hexadecimal format, and mixed hex and ASCII format (see the ASCII Character Chart on 
page 80 for reference).

A command string is constructed in the following format:

SOH R Data STX Command ETB ETX

Portions of the command string are defined as follows:

SOH (Start of Header) In hex, this is 01. In ASCII, this is ^A.

R This portion of the command string signifies that the message is an R-Type 
command. In hex, this is 02.

Data This portion consists of the information to be executed. This information 
is optional and is only required if the specific remote control command 
requires additional information, such as a project name, to properly 
execute the command.

STX (Start of Transmission) In hex, this is 02. In ASCII, this is ^B.

Command This portion contains the remote command type.

ETB (End of Block) In hex, this is 17. In ASCII, this is ^W.

ETX (End of Transmission) In hex, this is 03. In ASCII, this is ^C.

The contents of the portions denoted by Data and Command vary according to the required 
function and can be determined from the command table. Hex portions in a command 
string are denoted in brackets. 

NOTE:	 The spaces between characters are included for clarity only and must not 
appear in the transmitted message. The only permitted spaces within a string are in 
scene names.

The following example is a remote control string in ASCII format. This example runs a scene 
with the name “ATTRACT”: 
^A R ATTRACT ̂ B 07 ̂ W ̂ C

•	 The hex version of the above command string is: 
[01][52][41][54][54][52][41][43][54][02][30][37][17][03]

•	 A more common approach (compared to creating a string entirely in hex pairs or in 
ASCII), is to mix hex and ASCII data. This makes the string more readable. 

The mixed version of the above command string is: 
[01] R ATTRACT [02] 07 [17] [03] 
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Command Symbol Definitions

X!	 =	 Scene location in list (1 to 999)

X@	 =	 Scene name (ASCII, case-sensitive)

X#	 =	 Window number (0000 to 0998, zero-based, leading zeros required) 
Example: Window 25 = 0024

X$	 =	 Zoom percentage (000 to 999, leading zeros required) 
000 = No zoom 
500 = Zoom into 50 percent of image

X%	 =	 Pan horizontal location (000 to 999, leading zeros required) 
000 = Left-most edge of input video 
500 = Middle of image horizontally

X^	 =	 Pan vertical location (000 to 999, leading zeros required) 
000 = Top-most edge of input video 
500 = Middle of image vertically

X&	 =	 Window horizontal position (-9999 to 99999, leading zeros required) 
-0500 = 500 pixels off screen to the left 
01920 = 1920 pixels to the right of the left-most border

X*	 =	 Window vertical position (-9999 to 99999, leading zeros required) 
-0500 = 500 pixels above the top edge of the screen 
01080 = 1080 pixels below the top border

X(	 =	 Window horizontal size (00000 to 99999, leading zeros required) 
00400 = 400 pixels wide

X1)	 =	 Window vertical size (00000 to 99999, leading zeros required) 
00300 = 300 pixels tall

X1!	 =	 Input source name (ASCII, case-sensitive)

X1@	 =	 Window style name (ASCII, case-sensitive)

X1#	 =	 Border or overlay onscreen text (ASCII, case-sensitive)

X1$	 =	 Merge scene name (ASCII, case-sensitive)

X1%	 =	 Window layer number (0 to 999)

X1^	 =	 File location including the full directory path.  
Example: C:\Files\TestProject 
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Command Table

Command ASCII-Hexadecimal Description

Recall Scene

Recall by list position [01] R X! [02] 05 [17] [03] Recall scene number X! according to 
the scene list.

Example: [01] R04 [02] 05 [17] [03] Recall the fourth scene in the list in 
the Scene Design task.

Recall by scene name [01] R X@ [02] 07 [17] [03] Recall scene X@. 

Example: [01] R PRESET 2 [02] 07 [17] [03] Recall scene named “PRESET 2.”

Recall next scene [01] R [02] 0n [17] [03] Recall next scene in the list.

Recall previous scene [01] R [02] 0p [17] [03] Recall previous scene in the list.

Window Source

Select input [01] R X# X1! [02] 36 [17] [03] Select input X1! to be shown in 
window X#. 

Example: [01] R 0004 Laptop Input [02] 36 [17][03]

Set window 5 to display source 
named “Laptop Input.”

Select input in named scene [01] R X@,X#,X1! [02] 52 [17] [03] Route input X1! to window X# in 
scene X@.

NOTE:	 If you are using merge scenes, X@ must be remerged for the change to occur.

Autorun Controls

Begin from 1st scene [01] R [02] 0= [17] [03] Begin the autorun sequence with first 
scene in the list.

Begin from current scene [01] R [02] 0> [17] [03] Begin the autorun sequence from 
currently displayed scene.

Increase autorun speed [01] R [02] 0+ [17] [03] Increase the duration by 10 percent 
for each scene to be displayed.

Decrease autorun speed [01] R [02] 0- [17] [03] Decrease the duration by 10 percent 
for each scene to be displayed.

Stop autorun sequence [01] R [02] 0< [17] [03] Halt the autorun sequence.

Window Visibility

Hide Window [01] R X# 0 [02] 33 [17] [03] Set window X# to be hidden.

Example: [01] R 00050 [02] 33 [17] [03] Set window 6 to be hidden

Hide Multiple Windows [01] R X@,X#,X#,0 [02] 63 [17] [03] Set window X# through X# in scene 
X@ to be hidden.

NOTE:	 If you are using merge scenes, X@ must be remerged for the change to occur.

Show Window [01] R X# 1 [02] 33 [17] [03] Sets window X# to be shown.

Example: [01] R 00051 [02] 33 [17] [03] Sets window 6 to be shown.

Show Multiple Windows [01] R X@,X#,X#,1 [02] 63 [17] [03] Sets window X# through X# in scene 
X@ to be shown.

NOTE:	 If you are using merge scenes, X@ must be remerged for the change to occur.

NOTE:	 X!	 = Scene number			   Scene location in list (1 to 999) 
X@	 = Scene name			   ASCII, case-sensitive 
X#	 = Window number			   0000 to 0998, zero-based, leading zeros required 
X1!	= Input source name			  ASCII, case-sensitive
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Command ASCII-Hexadecimal Description

Window Size and Position

Set size and position [01] R X# X& X* X( X1) [02] 35 [17] [03] Set window X# to position ( X&, X* ) 
and size X( by X1).

Example: [01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

Set window 5 to position (300, 400) 
and size 800x600.

Set parameters in named scene [01] R X@,X# X& X* X( X1) [02] 57 [17] [03] Set window X# in scene X@ to position 
( X&, X* ) and size X( by X1).

NOTE:	 If you are using merge scenes, X@ must be remerged for the change to occur.

Window Priority

Bring window to front [01] R X@,X#,1 [02] 78 [17] [03] Bring window X# to be in front of all 
windows.

Send window to back [01] R X@,X#,0 [02] 78 [17] [03] Send window X# behind all windows.

Example: [01] R PRESET 2,0004,1 [02] 78 [17] [03]

Set window 5 in scene “PRESET 2” to 
be in front.

Bring window forward [01] R X@,X#,X1%, 1 [02] 79 [17] [03] Bring window X# forward X1% layers.

Send window backward [01] R X@,X#,X1%, 0 [02] 79 [17] [03] Send window X# backward X1% 
layers.

Example: [01] R PRESET 2,0004,3,0 [02] 79 [17] [03]

Send window 5 in scene “PRESET 2” 
backward 3 layers.

Zoom and Pan

Set zoom and pan [01] R X# X$ X% X^ [02] 34 [17] [03] Set window X# to have a zoom of X$ 
and pan of X% and X^. 

Example 1: [01] R 0004 500 000 000 [02] 34 [17] [03] Set window 5 to zoom in to 
50 percent of the image and to 
display the top left panel.

Example 2: [01] R 0004 750 750 750 [02] 34 [17] [03] Set window 5 to zoom in to 25% of 
the image and to display the bottom 
right panel.

NOTE:	 X@	 = Scene name			   ASCII, case-sensitive 
X#	 = Window number			   0000 to 0998, zero-based, leading zeros required 
X$	 = Zoom percentage			   000 to 999, leading zeros required 
X%	 = Pan horizontal location		  000 to 999, leading zeros required 
X^	 = Pan vertical location		  000 to 999, leading zeros required 
X&	 = Window horizontal position		  -9999 to 99999, leading zeros required 
X*	 = Window vertical position		  -9999 to 99999, leading zeros required 
X(	 = Window horizontal size		  00000 to 99999, leading zeros required 
X1)	= Window vertical size		  00000 to 99999, leading zeros required 
X1%	= Window layer number		  0 to 999
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Command ASCII-Hexadecimal Description

Zoom and Pan (continued)

Set horizontal and vertical zoom 
and horizontal and vertical pan

[01] R X#X&X*X%X^ [02] 40 [17] [03] Set window X# to have a zoom of X& 
horizontally and X* vertically, and a 
pan of X% and X^.

Example: [01] R 0004 500  750 000  000 [02] 34 [17] [03]

Set window 5 to zoom in to 
50% of the image horizontally and 
25% vertically, and to display the top 
left panel.

Set parameters in named scene [01] R  X@,X#X$X%X^ [02] 58 [17] [03] Set window X# in scene X@ to have a 
zoom of X$ and a pan of X% and X^. 

NOTE:	 If you are using merge scenes, X@ must be remerged for the change to occur.

Coordinate system:
The horizontal and vertical pan settings allow you to position the  
upper left corner of the zoomed region on a 1000 x 1000 grid  
that represents the original image. 

Set zoom and pan in named 
scene

[01] R X@,X#X&X*X%X^ [02] 59 [17] [03] Set window X# in scene X@ to have a 
zoom of X& and X* and a pan of X% 
and X^.

Window Style

Select style [01] R X# X1@ [02] 37 [17] [03] Set window X# to use predefined style 
X1@. 

Example: [01] R 0004 Arial 2 [02] 37 [17] [03] Set window 5 to use window style 
named “Arial 2.”

Select style in named scene [01] R X@,X#,X1@ [02] 53 [17] [03] Set window X# in scene X@ to use 
style X1@. 

NOTE:	 If you are using merge scenes, X@ must be remerged for the change to occur.

Define border text [01] R X# X1# [02] 38 [17] [03] Set window X# to have border text 
which states X1#. 

Example: [01] R 0004 Auxiliary Input [02] 38 [17] [03]

Set window 5 to have border text 
stating “Auxiliary Input.”

NOTE:	 X@	 = Scene name			   ASCII, case-sensitive 
X#	 = Window number		  0000 to 0998, zero-based, leading zeros required 
X$	 = Zoom percentage		  000 to 999, leading zeros required 
X%	 = Pan horizontal location		  000 to 999, leading zeros required 
X^	 = Pan vertical location		  000 to 999, leading zeros required 
X&	 = Window horizontal position	 -9999 to 99999, leading zeros required 
X*	 = Window vertical position		  -9999 to 99999, leading zeros required 
X1@	 = Window style name		  ASCII, case-sensitive 
X1#	 = Border or overlay onscreen text	 ASCII, case-sensitive
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Command ASCII-Hexadecimal Description

Window Style (continued)

Set border text in named scene [01] R X@,X#,X1# [02] 54 [17] [03] Set window X# in scene X@ to have 
border text X1#. 

NOTE:	 If you are using merge scenes, X@ must be remerged for the change to occur.

Define overlay text [01] R X# X1# [02] 39 [17] [03] Set window X# to have overlay text 
stating X1#.

Example: [01] R 0004 CONFIDENTIAL [02] 39 [17] [03]

Set window 5 to have overlay text 
stating “CONFIDENTIAL.”

Set overlay text in named scene [01] R X@,X#,X1# [02] 55 [17] [03] Set window X# in scene X@ to have 
overlay text X1#.

NOTE:	 If you are using merge scenes, X@ must be remerged for the change to occur.

Batch Execute Commands

Begin command collection [01] R [02] 41 [17] [03] All commands after this string are 
collected but not executed.

Execute collected commands [01] R [02] 42 [17] [03] Execute all commands issued 
between the Begin and Execute 
strings.

Example: [01] R [02] 41 [17] [03]
[01] R PRESET 2 [02] 07 [17] [03]
[01] R 0004 Laptop Input [02] 36 [17] [03]
[01] R 0004 CONFIDENTIAL [02] 38 [17] [03]
[01] R [02] 42 [17] [03]

Begin collecting commands. The 
following three commands are 
executed simultaneously after the last 
line is sent:

•	 Recall the scene named 
“PRESET 2.”

•	 Set window 5 to display the 
source named “Laptop Input.”

•	 Set window 5 to have overlay 
text stating CONFIDENTIAL.

Merge Scene Controls

Create merge scene [01] R X1$,,,1 [02] 51 [17] [03] Create new merged scene X1$. 

Add or remerge scene [01] R X1$,,X@,1 [02] 51 [17] [03] Add or remerge existing scene X@ to 
merge scene X1$. 

Delete scene [01] R X1$,X@,,1 [02] 51 [17] [03] Remove scene X@ from scene X1$.

Purge merge scene [01] R [02] 56 [17] [03] Remove all windows from the current 
merge scene.

[01] R X1$ ,,,1 [02] 51 [17] [03] Refresh merge scene X1$ to have all 
windows removed.

NOTE:	 X@	 = Scene name			   ASCII, case-sensitive 
X#	 = Window number			   0000 to 0998, zero-based, leading zeros required 
X1#	= Border or overlay onscreen text	 ASCII, case-sensitive 
X1$	= Merge scene name		  ASCII, case-sensitive
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Command ASCII-Hexadecimal Description

Save Current Project to File

Save current project [01] R X1^ [02] 11 [17] [03] Save current project to location X1^ 
(includes the full directory path).

Example: [01] R C:\Files\
TestProject [02] 11 [17] [03]

Save current project to C:\Files 
with a filename of “TestProject.”

NOTE:	 The folder in which the file will be saved must already be created.

Examples of R-type Messages
The following examples of R-type messages assume that there are five scenes in the 
currently loaded project and that they appear in the scene list as:

•	 Intro

•	 Video

•	 Demo

•	 Conference

•	 Finish

NOTE:	 The spaces between characters are included for clarity only and must not 
appear in the transmitted message.

To select the Conference scene by its name: 
	 ^AR Conference ̂ B 07 ̂ W^C

To select the Demo scene by its position in the scene list: 
	 ^AR 3 ̂ B 05 ̂ W^C

To select the next scene in the scene list: 
	 ^AR ̂ B 0n ̂ W^C

To start AutoPlay from the first scene (in this case, the Intro scene): 
	 ^AR ̂ B 0= ̂ W^C

To stop AutoPlay: 
	 ^AR ̂ B 0< ̂ W^C

To increase AutoPlay playback speed by 10 percent: 
	 ^AR ̂ B 0+ ̂ W^C

To hide or show window 7 in the current scene: 
	 ^AR 0006 0 ̂ B 33 ̂ W^C (hides the window) 
	 ^AR 0006 1 ̂ B 33 ̂ W^C (shows the window)

To set window 4 to the “Warning” style: 
	 ^AR 0003 Warning ̂ B 37 ̂ W^C

To set the overlay text of window 4 to read “Incident Reported”: 
	 ^AR 003 Incident Reported ̂ B 39 ̂ W^C

To set the viewport of window 5 to show a magnified area from the center of the 
source image: 
	 ^AR 0004 500 250 250 ̂ B 34 ̂ W^C
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Merge Scene Commands
Merge scene commands (51-56) provide independent control of areas on a display wall that 
are driven from a Quantum processor or array of processors. This is useful for installations 
where more than one operator needs access to the display wall (see Working with Merge 
Scenes on page 90 for more information about merge scene functions).

A merge scene allows sources on different areas of the display wall to be merged into the 
overall scene.

To create a merge scene called “Merge Scene”: 
	 ^AR Merge Scene,,,1 ̂ B 51 ̂ W^C

To add a scene called “Op 1 scene 1” in “Merge Scene”: 
	 ^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C 

NOTE:	 “Op1 scene 1” must already be created in the Quantum Control Software.

To remove the “Op1 scene 1” scene and add the “Op1 scene 2” scene to the merge 
scene: 
	 ^AR Merge Scene,,Op1 scene 1,Op1 scene 2,1 ̂ B 51 ̂ W^C

To change the source that is applied to a certain window in a scene, two commands 
are sent: 
	 ^AR Op1 scene 2,0,New Source 1 ̂ B 52 ̂ W^C (applies “New Source 1”  
	 source to window “0” in the “Op1 scene 2” scene) 
	 ^AR Merge Scene,,Op1 scene 2,1 ̂ B 51 ̂ W^C (refreshes the merged  
	 scene)

To change the window style, use command 53 and refresh the merge scene: 
	 ^AR Op1 scene 2,0, Arial 1 ̂ B 53 ̂ W^C 
	 ^AR Merge Scene,,Op1 scene 2,1 ̂ B 51 ̂ W^C

To change the border text on a window, use command 54 and refresh the merge 
scene: 
	 ^AR Op1 scene 2,0, Camera 15 ̂ B 54 ̂ W^C 
	 ^AR Merge Scene,,Op1 scene 2,1 ̂ B 51 ̂ W^C

To change the overlay text on a window, use command 55 and refresh the merge 
scene: 
	 ^AR Op1 scene 2,0, Camera 15 ̂ B 55 ̂ W^C 
	 ^AR Merge Scene,,Op1 scene 2,1 ̂ B 51 ̂ W^C

To remove all of the windows from the merge scene, use the Purge scene command 
(56) and refresh the scene: 
	 ^AR ̂ B 56 ̂ W^C 
	 ^AR Merge Scene,,,1 ̂ B 51 ̂ W^C
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ASCII Character Chart
The ASCII character chart below is provided as a reference for creating your serial data 
strings.

Dec Hex ASCII
CTRL 
Key Dec Hex ASCII Dec Hex ASCII Dec Hex ASCII

0 0 NULL ^@ 32 0x20 <SPACE> 64 0x40 @ 96 0x60 `

1 1 SOH ^A 33 0x21 ! 65 0x41 A 97 0x61 a

2 2 STX ^B 34 0x22 “ 66 0x42 B 98 0x62 b

3 3 ETX ^C 35 0x23 # 67 0x43 C 99 0x63 c

4 4 EOT ^D 36 0x24 $ 68 0x44 D 100 0x64 d

5 5 ENQ ^E 37 0x25 % 69 0x45 E 101 0x65 e

6 6 ACK ^F 38 0x26 & 70 0x46 F 102 0x66 f

7 7 BEL ^G 39 0x27 ‘ 71 0x47 G 103 0x67 g

8 8 BS ^H 40 0x28 ( 72 0x48 H 104 0x68 h

9 9 HT ^I 41 0x29 ) 73 0x49 I 105 0x69 i

10 A LF ^J 42 0x2A * 74 0x4A J 106 0x6A j

11 B VT ^K 43 0x2B + 75 0x4B K 107 0x6B k

12 C FF ^L 44 0x2C , 76 0x4C L 108 0x6C l

13  D CR ^M 45  0x2D - 77 0x4D M 109 0x6D m

14 E SO ^N 46 0x2E . 78 0x4E N 110 0x6E n

15 F SI ^O 47 0x2F / 79 0x4F O 111 0x6F o

16 10 DLE ^P 48 0x30 0 80 0x50 P 112 0x70 p

17 11 DC1 ^Q 49 0x31 1 81 0x51 Q 113 0x71 q

18 12 DC2 ^R 50 0x32 2 82 0x52 R 114 0x72 r

19 13 DC3 ^S 51 0x33 3 83 0x53 S 115 0x73 s

20 14 DC4 ^T 52 0x34 4 84 0x54 T 116 0x74 t

21 15 NAK ^U 53 0x35 5 85 0x55 U 117 0x75 u

22 16 SYN ^V 54 0x36 6 86 0x56 V 118 0x76 v

23 17 ETB ^W 55 0x37 7 87 0x57 W 119 0x77 w

24 18 CAN ^X 56 0x38 8 88 0x58 X 120 0x78 x

25 19 EM ^Y 57 0x39 9 89 0x59 Y 121 0x79 y

26 1A SUB ^Z 58 0x3A : 90 0x5A Z 122 0x7A z

27 1B ESC ^[ 59 0x3B ; 91 0x5B [ 123 0x7B {

28 1C FS ^\ 60 0x3C < 92 0x5C \ 124 0x7C |

29 1D GS ^] 61 0x3D = 93 0x5D ] 125 0x7D }

30 1E RS ^^ 62 0x3E > 94 0x5E ^ 126 0x7E ~

31 1F US ^_ 63 0x3F ? 95 0x5F _ 127 0x7F <Del>
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Access Control

This section describes access control that is incorporated in the Quantum Control Software, 
allowing different operators to gain access to different tasks. Topics that are covered 
include:

•	 Login Procedure

•	 Enabling and Disabling Access Control

•	 Changing Level Passwords

Login Procedure
The Quantum Control Software incorporates an access control system that allows different 
operators to have access to different tasks according to their needs and responsibilities. 
This feature helps to prevent end users from being able to make unauthorized changes to 
the setup of the Quantum Control system.

The following table lists the three available access levels and the tasks that are accessible to 
each level. 

Task

Access Level

Administrator Designer User

Choose Display 
Processors

X X

Choose Layout X

Communications Setup X

Set Up Sources X

Scene Design X X

Scene Control X X X 
(See the note below.)

Remote Access Setup X X

EDID Minder X

NOTE:	 When you log in as a User, the Scene Control task opens in full screen mode 
(run view only, not design view). To return to normal screen mode (such as to adjust 
the brightness setting), press the <Esc> key on the keyboard. To return to full screen 
mode, click the Scene Control button on the taskbar.

With the access control feature enabled, a Login dialog box opens each time you start the 
Quantum Control Software (see figure 50 on the next page).
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Figure 50.	 Login Dialog Box

To log in to the Quantum Control Software:

1.	 From the User drop-down list, select the desired role.

2.	 In the Password field, enter the required password for the chosen role.

3.	 Click OK or press the <Enter> key on the keyboard to continue. The  
Quantum Control Software splash screen appears for a few seconds, followed by the 
main application window (see Main Application Window on page 8).

NOTES:	

•	 By default, the password for each operator role is the same as the user name. For 
example, for the User role, the password is User.

•	 Passwords are case-sensitive.

Enabling and Disabling Access Control
Following a new installation of the Quantum Control Software, the access control system is 
disabled. Anyone using the application has access to all areas of functionality.

NOTE:	 Access control can be enabled by any user. However, after it has been enabled, 
it can only be disabled by an Administrator.

To enable access control:

From the Access Control menu, select Enable Access Control. Access control is 
enabled the next time you close and restart the Quantum Control Software.

To disable access control:

1.	 Start the Quantum Control Software application and log in as an Administrator  
(see Login Procedure on page 81).

2.	 From the Access Control menu, select Disable Access Control. Access control is 
disabled the next time that the Quantum Control Software is closed and restarted.
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Changing Level Passwords
By default, the password for each access level is the same as the level name. For example, 
for the User level, the password is User.

NOTE:	 Passwords are case-sensitive. For example, if the password is User, entering 
user or USER is not recognized.

It is recommended that the default passwords are changed as soon as possible after 
installation. A password can contain any standard keyboard letters, numbers, or symbols 
and can be any length.

Passwords can be changed only by an Administrator, following the login procedure.

To change a role password:

1.	 Start the Quantum Control Software and log in as an Administrator.

2.	 From the Access Control menu, select Change Access Passwords. The Change 
Passwords dialog box opens.

Figure 51.	 Change Passwords Dialog Box

3.	 From the Role drop-down list, select the appropriate operator role.

4.	 The current password for that role appears in the Password field. Change the password 
as needed.

5.	 Click OK to save the new password or click Cancel to retain the existing password. The 
new password takes effect the next time you close and restart the Quantum Control 
Software.
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Reference 
Information

This section discusses how to apply window styles to source windows on a Quantum 
display by modifying the XML file installed with the Quantum Control Software. This section 
also explains merge scene functionality and how to assign IP addresses for your devices. 
Topics include:

•	 Modifying Window Styles

•	 Working with Merge Scenes

•	 IP Addressing

Modifying Window Styles

Overview
The Quantum Control Software allows you to apply window styles to source windows on a 
Quantum display. Styles specify the following features for source windows:

•	 Border of a specified color and width

•	 Title bar of a specified font, size, and color

•	 Text overlay of a specified font, size, and color

Title text displays on a solid background that is the same color as the border. Overlay text is 
placed on top of the source image and does not have a background.

NOTE:	 Although a window can have both overlay text and title text at the same time, 
typically only one of these is used. 

Styles are defined by an XML file that is installed on the PC hard disk when you install the 
Quantum Control Software. You can add new styles or modify existing styles by editing the 
XML file.

NOTES:	

•	 The XML file is a separate file and is not part of the project (CTP) file. Always keep a 
backup copy of the XML file. Any time you reinstall the Quantum Control Software, 
the XML file is overwritten with the default version, and any changes that were 
made to the file are lost. Copying projects from one computer to another requires 
both the CTP and the XML files to be copied.

•	 After reinstalling the Quantum Control Software, always replace the default XML 
file with your customized XML file before starting the Quantum Control Software. 
Otherwise, if you start the application with a project file that references nonexistent 
styles, the missing styles are removed from all affected windows. If the project file is 
saved at this point, it is saved without the required styles. If you reinstall the correct 
XML file at this point, you must manually reapply the missing styles to each affected 
window in the project file.
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Locating and Opening the XML File
You can edit the XML file using Microsoft Notepad or a proprietary XML editor if available. To 
edit the file using Notepad:

1.	 From the desktop, click Start > All Programs > Accessories > Notepad. This opens 
the Notepad application.

2.	 From the File menu, select Open. The Open dialog box is displayed.

3.	 From the Files of type drop-down list, select All Files.

4.	 Browse to and select the XML file. By default, the file is located in the following folder on 
the computer hard disk:

C:\Program Files\Extron\Quantum Elite [or Connect]\XML\Quantum Source 
Types

- or -

C:\Program Files (x86)\Extron\Quantum Elite [or Connect]\XML\Quantum 
Source Types 

The file is named ESQuantumConfig.xml.

5.	 Click Open.

The XML file looks similar to the following:

Figure 52.	 ESQuantumConfig.xml File

NOTE:	 Before you make any changes to this file, it is strongly recommended that 
you create a backup copy. From the File menu, select Save As to open the Save 
As dialog box and save a backup copy.

TIP:	 To make the text easier to read in Notepad, it is recommended that you turn 
off the Wordwrap feature (via the Format menu).

6.	 In the file, scroll down to the <WindowStyles> (opening) tag. The lines of information 
between this tag and the </WindowStyles> (closing) tag define all of the styles that 
appear in the Quantum Control Software.
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Overview of the Style Tag
Each style is defined with a separate <Style> tag. For example, the tag for the default style  
is defined by:

<Style Id=”Default” Name=”Default Style”> 
<Title Show=”1” Font=”Verdana” Size=”14” Bold=”1” HorizPosition=”Centre” 
VertPosition=”Bottom” Colour=”153,204,255” Flash=”0”/> 
<Overlay Show=”1” Font=”Verdana” Size=”14” Bold=”1” HorizPosition=”Left” 
VertPosition=”Bottom” Colour=”153,204,255” Flash=”0”/> 
<Border Show=”0” Colour=”51,51,51” Thickness=”2” Flash=”0”/> 
</Style>  

•	 In the <Style Id=”Default” Name =”Default Style”> line of the example:

Name is the name of the style as it will appear on the Window Styles tab of the Window 
Properties dialog box in the Quantum Control Software.

Id is a short name or reference for the style and identifies the style in RS-232 control 
messages.

•	 The <Title> tag defines the attributes of the title bar, including font style, size, and 
color:

<Title Show=”1” Font=”Verdana” Size=”14” Bold=”1” 
HorizPosition=”Centre” VertPosition=”Bottom” Colour=”153,204,255” 
Flash=”0”/>

•	 The <Overlay> tag defines the attributes of the border:

<Overlay Show=”1” Font=”Verdana” Size=”14” Bold=”1” 
HorizPosition=”Left” VertPosition=”Bottom” Colour=”153,204,255” 
Flash=”0”/>   

•	 The <Border> tag defines the attributes of the border:

<Border Show=”0” Colour=”51,51,51” Thickness=”2” Flash=”0”/>  

•	 The </style> tag is the closing tag.

Many of the attributes are common to each tag and are listed in the Summary of Style 
Attributes table on the next page.
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Summary of Style Attributes

Attribute Function Values

Show Sets the text or border as visible 
or hidden.

•	 0 = hidden

•	 1 = visible

Font The font name chosen from the 
fonts that are installed on the 
Quantum processor

Default fonts are:

•	 Arial

•	 Verdana

•	 Microsoft Sans Serif

•	 Tahoma

Size Sets the size of the font. The 
larger the number, the bigger the 
text.

Depends on display resolution 
and size. Typically, a value from 
10 through 40 provides readable 
results.

Bold Sets the font weight. •	 0 = normal

•	 1 = bold

HorizPosition Defines the horizontal alignment 
of the text.

•	 Left

•	 Centre

•	 Right

VertPosition Defines the vertical alignment of 
the text.

•	 Top

•	 Centre

•	 Bottom

NOTE:	 Center alignment is not 
applicable to title text.

Thickness Defines the width of the border. Width in pixels. Typically 1 through 
10 are acceptable values.

Colour Defines the color of the text or 
border using RGB colors.

Values between 0 and 255:

•	 0,0,0 = black

•	 255,255,255 = white

•	 255,0,0 = red

•	 0,255,0 = green

•	 0,0,255 = blue

Flash Defines whether the text or border 
is static or flashing.

•	 0 = static

•	 1 = flashing
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Modifying an Existing Style
To modify an existing style:

1.	 Edit the appropriate attributes as needed.

For example, to change the default style to use Arial font on the title bar with the text 
aligned to the left, change the attribute values shown in italics:

<Style Id=”Default” Name=”Default Style”> 
<Title Show=”1” Font=”Arial” Size=”14” Bold=”1” HorizPosition=”Left” 
VertPosition=”Bottom” Colour=”153,204,255” Flash=”0”/> 
<Overlay Show=”1” Font=”Verdana” Size=”14” Bold=”1” 
HorizPosition=”Left” VertPosition=”Bottom” Colour=”153,204,255” 
Flash=”0”/> 
<Border Show=”0” Colour=”51,51,51” Thickness=”2” Flash=”0”/> 
</Style> 

2.	 From the File menu in Notepad, select Save to save any changes that you made.

3.	 Restart the Quantum Control Software to load the new style.

Adding a New Style
The easiest way to add a new style is to copy and paste an existing style, then modify it.

For example, to create a new style called “My Style” with the following attributes:

Attribute Value

Title Bar Text

Font Tahoma

Size 12

Bold No

Position Top Right

Colour 240,240,0 (Yellow)

Overlay Text

Font Tahoma

Size 12

Bold No

Position Centre

Colour 240,0,0 (Red)

Border
Width 3

Colour 128,128,128 (Gray)
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1.	 Select an existing style in the XML file.

NOTE:	 You must include the opening and closing Style tag.

Figure 53.	 Selecting an Existing Style in the XML File

2.	 Right-click the selected text and select Copy from the drop-down menu.

3.	 Paste the selected text between Style tags (after a </Style> tag and before the 
<Style> tag that follows it). To do so:

a.	 Click behind a </Style> tag.

b.	 Press the <Enter> key. The cursor moves to a new line above the next <Style> 
tag.

c.	 Press the <Tab> key on your keyboard to align the cursor with the previous  
</Style> tag.

d.	 Right-click in the blank line and select Paste from the drop-down menu.

4.	 Modify the copied style to reflect the necessary attributes (see the Adding a New Style 
table on the previous page). The text for the new style appears as follows:

<Style Id=”MyStyle” Name=”My Style”> 
<Title Show=”1” Font=”Tahoma” Size=”12” Bold=”0” HorizPosition=”Right” 
VertPosition=”Top” Colour=”240,240,0” Flash=”0”/> 
<Overlay Show=”1” Font=”Tahoma” Size=”12” Bold=”0” 
HorizPosition=”Centre” VertPosition=”Centre” Colour=”240,0,0” 
Flash=”0”/> 
<Border Show=”0” Colour=”128,128,128” Thickness=”3” Flash=”0”/> 
</Style>  

5.	 From the File menu in Notepad, select Save to save any changes that you made.

6.	 Restart the Quantum Control Software to load the new style.
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Working with Merge Scenes

Merge Scene Overview
A merge scene allows sources on different areas of a display wall to be merged into 
the overall scene. The merge scene acts as a master scene while other scenes act as 
subscenes. Each subscene is unique and is managed independently from one another. This 
is useful when dividing the pixel map into logical groups or display areas for independent 
control.

1.	 Define the independent displays or display groups and allocate one or more subscenes 
for each.

2.	 Program and control the subscenes as needed.

3.	 Add or remove subscene data to or from the merge scene.

4.	 Refresh the merge scene. This is required in order for merge scene changes to take 
effect.

Defining Displays or Display Groups
To create a merge scene, define which displays or display groups are to be independently 
controlled. 

In the following example, there are nine display groups:

•	 Display group 1 is a 2x4 videowall.

•	 Display group 2 through 9 are independent LCD panels.

In figure 54, the display group numbers are shown in white.

Figure 54.	 Display Groups
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Programming Subscenes
After you define the display groups, create the subscenes that belong to each group. In 
the following examples, scene group 1 has eight subscenes titled “Videowall1” through 
“Videowall8” (see figure 54 on the previous page). Each subscene has a unique layout.

Scene group 1

Figure 55.	 Videowall1 Subscene

Figure 56.	 Videowall2 Subscene
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Figure 57.	 Videowall3 Subscene

Scene group 2

Screen group 2 has three subscenes, LCD1-1 through LCD1-3, allocated to it. Each 
subscene is programmed to have a unique layout as shown in the following examples.

Figure 58.	 LCD1-1 Subscene
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Figure 59.	 LCD1-2 Subscene

Figure 60.	 LCD1-3 Subscene

The remaining subscenes (subscene 3 through subscene 9), are allocated to the remaining 
LCD displays (LCD2 through LCD8). These subscenes follow the same convention as 
subscene 2 (LCD1).
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Workflow

The merge scene should be the only scene that is running (active) in the Quantum Control 
Software. The merge scene is highlighted in the scene list to indicate that it is the currently 
active scene.

NOTE:	 Direct all control commands to a specific subscene, not to the merge scene.

The following sample workflow uses the previous subscene examples. 

1.	 Add a subscene to a merge scene. This essentially calls or runs the subscene.

For example, add Videowall1 to Merge Scene: 
[01] RMerge Scene,,Videowall1,1 [02] 51 [17] [03]

2.	 Make the desired changes to a subscene.

For example, set Videowall1/Window1 to SourceRGB1: 
[01] RVideowall1,0,RGB1 [02] 52 [17] [03]

3.	 Update the merge scene with the changed information from step 2, above.

NOTE:	 This step is required in order for changes to take effect.

For example, the following adds Videowall1 to the merge scene and applies updated 
subscene information: 
[01] RMerge Scene,,Videowall1,1 [02] 51 [17] [03]

4.	 Change one scene to the next scene.

For example, remove Videowall1 and add Videowall2: 
[01] RMerge Scene,Videowall1,Videowall2,1 [02] 51 [17] [03]

The window index numbers in the merge scene increment dynamically. The window index 
numbers in the subscene are left unchanged. 

When making several changes to a subscene, it may be more efficient to wait until all of the 
changes have been made before executing a final refresh of the merge scene.

For example:

Videowall1/Window1 set to SourceRGB1 
Videowall1/Window2 set to SourceRGB2 
Videowall1/Window3 set to SourceRGB3

[01] RVideowall1,0,RGB1 [02] 52 [17] [03] 
[01] RVideowall1,1,RGB3 [02] 52 [17] [03] 
[01] RVideowall1,3,RGB3 [02] 52 [17] [03] 
[01] RMerge Scene,,Videowall1,0 [02] 51 [17] [03] 
[01] RMerge Scene,,,1 [02] 51 [17] [03]

It may be beneficial to write a subroutine that tracks which subscene is currently running 
when you are changing scenes. The subroutine indicates the subscene that needs to be 
removed from the merge scene before the next subscene can be added.
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IP Addressing

What is an IP Address?
A full explanation of IP addressing is beyond the scope of this user guide. However, the 
following details provide enough information to get started.

An IP address is a 32-bit binary number that is used to identify each device on an Ethernet 
network. This number is usually represented by four decimal numbers (each in the range 
of 0 to 255) separated by dots, such as 198.123.34.240. This is called “dotted decimal 
notation.”

An IP address is divided into two parts:

•	 Network identifier

•	 Host identifier

Each address on a given network must have the same network identifier value but have a 
unique host identifier. As a result, there are different classes that define the range of valid 
addresses and the parts of the address that are used for the network and host identifiers.

The most common IP address classes are:

Class Name Valid Address Range Identifier Arrangement

Class A 0.0.0.1 to 127.255.255.254 NNN.HHH.HHH.HHH

Class B 128.0.0.1 to 191.255.255.254 NNN.NNN.HHH.HHH

Class C 192.0.0.1 to 223.255.255.254 NNN.NNN.NNN.HHH

NNN refers to the network identifier and HHH refers to the host identifier.

Choosing IP Addresses
If the Quantum Control Software computer and Quantum processors are directly connected 
or connected via their own independent network, follow the guidelines below for choosing 
the IP addresses.

However, if you intend to connect your computer and Quantum processors to an existing 
network, you need to advise the network administrator and ask the administrator to allocate 
suitable IP addresses.

On an independent network, it is generally recommended that you use the Class C format 
(from 192.0.0.1 to 223.255.255.254).

There are two rules for choosing IP addresses:

•	 Network identifier must be the same for each IP address

•	 Host identifier must be unique for each address.

Applying these rules to Class C addresses, the first three decimal values of your IP address 
must all be the same while the last value is used to uniquely identify each device.
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The following is an example of a valid Class C addressing scheme:

Device IP Address

Quantum Control Software Computer 208.132.180.41

Quantum processor 1 208.132.180.42

Quantum processor 2 208.132.180.43

NOTE:	 The host identifiers (41, 42, and 43 in the above example) do not need to be 
sequential or in any particular order. However, it is recommended that you group the 
numbers for simplicity.

The following is an example of an invalid Class C addressing scheme:

Device IP Address

Quantum Control Software Computer 208.132.180.41

Quantum processor 1 192.157.180.42

Quantum processor 2 209.100.123.43

NOTE:	 The above addresses are invalid because the network identifier for each address 
is not the same even though each IP address is unique.

You can perform a test from your computer to check that a device at a particular address is 
responding correctly (see Testing the Ethernet Link on page 6).

Subnet mask

The subnet mask is another 32-bit binary number that is used to “mask” certain bits of the 
IP address. This provides a method of extending the number of network options for a given 
IP address. It works by allowing part of the host identifier to be used as a subnet identifier.

It is important that you set the correct value for the subnet mask. The basic values depend 
on the class of IP address being used. 

Class Name Subnet Mask

Class A 255.0.0.0

Class B 255.255.0.0

Class C 255.255.255.0
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